HP DesignJet T120 and T520 Printer Series

User Guide
Legal notices

The information contained herein is subject to change without notice.

The only warranties for HP products and services are set forth in the express warranty statement accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

Hi-Speed USB certified

IPv6-ready

Wi-Fi certified

Trademarks

Adobe®, Acrobat®, and Adobe Photoshop® are trademarks of Adobe Systems Incorporated.

Corel® is a trademark or registered trademark of Corel Corporation or Corel Corporation Limited.

ENERGY STAR and the ENERGY STAR mark are registered U.S. trademarks.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
# Table of contents

1 Introduction ................................................................................................................................. 1  
   Safety precautions .......................................................................................................................... 2  
   HP Start-Up Kit ............................................................................................................................... 2  
   Using this guide ............................................................................................................................... 2  
   Printer models ................................................................................................................................ 3  
   Main features .................................................................................................................................. 4  
   Main components ............................................................................................................................. 5  
   Front panel ....................................................................................................................................... 7  
   Printer software ................................................................................................................................. 8  
   Mobile Printing ................................................................................................................................. 9  
   Turn the printer on and off ............................................................................................................... 10  
   The printer's internal prints ............................................................................................................. 11  

2 Connecting the printer .................................................................................................................... 12  
   Choose which connection method to use ......................................................................................... 13  
   Connect the printer to your network ............................................................................................... 13  
   Connect a computer to the printer by network (Windows) ............................................................... 13  
   Connect a computer to the printer by USB cable (Windows) ......................................................... 14  
   Connect a computer to the printer by network (Mac OS X) ............................................................ 15  
   Connect a computer to the printer by USB cable (Mac OS X) ....................................................... 17  

3 Setting up the printer ..................................................................................................................... 19  
   Introduction ...................................................................................................................................... 20  
   Automatic firmware update ............................................................................................................ 20  
   Turn email notifications on and off ............................................................................................... 20  
   Turn alerts on and off ....................................................................................................................... 20  
   Control access to the Embedded Web Server ................................................................................ 21  
   Set Windows driver preferences ..................................................................................................... 21  
   Set up Web Services and Mobile Printing ....................................................................................... 22  

4 Personalizing the printer ................................................................................................................ 23  
   Change the language of the front-panel display ............................................................................ 24  
   Access the Embedded Web Server ............................................................................................... 24  
   Change the language of the Embedded Web Server .................................................................... 24
5 Paper handling .................................................................................................................................................. 29
  General paper-loading advice ............................................................................................................................ 30
  Load a roll onto the spindle ................................................................................................................................. 30
  Load a roll into the printer .................................................................................................................................. 32
  Unload a roll ...................................................................................................................................................... 34
  Load a single sheet ........................................................................................................................................... 34
  Unload a single sheet ........................................................................................................................................ 35
  Use the multi-sheet tray .................................................................................................................................. 35
  View information about the paper ..................................................................................................................... 37
  Maintain paper ................................................................................................................................................... 37
  Change the drying time .................................................................................................................................... 37
  Turn the automatic cutter on and off .................................................................................................................. 37
  Form feed with or without cutting ..................................................................................................................... 38

6 Printing ............................................................................................................................................................ 39
  Mobile Printing ................................................................................................................................................ 40
  Print with HP Click ......................................................................................................................................... 41
  Printing from a computer using a printer driver ............................................................................................... 41

7 Practical printing examples ............................................................................................................................. 48
  Print from Adobe Acrobat ................................................................................................................................. 49
  Print from Autodesk AutoCAD .......................................................................................................................... 51
  Print from Adobe Photoshop ............................................................................................................................. 55
  Print and scale from Microsoft Office ............................................................................................................... 57

8 Handling ink cartridges and printhead ........................................................................................................... 64
  About the ink cartridges .................................................................................................................................. 65
  Storage of anonymous usage information ......................................................................................................... 65
  Check ink cartridge status ................................................................................................................................. 65
  Replace an ink cartridge .................................................................................................................................. 65
  About the printhead .......................................................................................................................................... 67

9 Maintaining the printer ..................................................................................................................................... 68
  Check printer status ........................................................................................................................................... 69
Take care of the printer .................................................................................................................. 69
Clean the exterior of the printer ................................................................................................. 69
Print Quality Diagnostic Report .................................................................................................. 69
Clean the printhead ....................................................................................................................... 70
Align the printhead ....................................................................................................................... 71
Replace the printhead .................................................................................................................... 71
Clean the encoder strip .................................................................................................................. 76
Recalibrate the paper advance ...................................................................................................... 76
Move or store the printer .............................................................................................................. 77
Firmware update .......................................................................................................................... 77
Software update ........................................................................................................................... 78
Printer maintenance kits .............................................................................................................. 78

10 Accessories .............................................................................................................................. 79
  How to order supplies and accessories ..................................................................................... 80
  Introduction to the accessories .................................................................................................. 83

11 Troubleshooting paper issues ................................................................................................ 84
  Paper cannot be loaded successfully ......................................................................................... 85
  Paper type is not in the driver .................................................................................................... 87
  Printer printed on the wrong paper type ................................................................................... 88
  Paper mismatch ......................................................................................................................... 88
  Roll has jammed ......................................................................................................................... 88
  Multi-sheet tray has jammed ...................................................................................................... 90
  A strip stays on the output tray and generates jams ................................................................. 92
  Printer displays out of paper when paper is available .............................................................. 92
  Prints do not fall neatly into the bin ......................................................................................... 92
  Sheet stays in the printer when the print has been completed .................................................. 92
  Paper is cut when the print has been completed ..................................................................... 93
  Cutter does not cut well ............................................................................................................. 93
  Roll is loose on the spindle ....................................................................................................... 93

12 Troubleshooting print-quality issues ....................................................................................... 94
  General printing advice .......................................................................................................... 95
  Horizontal lines across the image (banding) .......................................................................... 95
  Lines are too thick, too thin or missing .................................................................................... 96
  Lines appear stepped or jagged ............................................................................................... 96
  Lines print double or in the wrong colors ............................................................................... 97
  Lines are discontinuous .......................................................................................................... 97
  Lines are blurred ...................................................................................................................... 98
  Line lengths are inaccurate ..................................................................................................... 98
  Whole image is blurry or grainy .............................................................................................. 99
  Paper is not flat ......................................................................................................................... 99
13 Troubleshooting ink cartridge and printhead issues ................................................................. 105
   Cannot insert an ink cartridge .......................................................................................... 106
   Ink cartridge status messages ....................................................................................... 106
   Cannot insert the printhead .......................................................................................... 106

14 Troubleshooting data communication issues .................................................................... 107
   Communication failures between computer and printer .................................................. 108
   Wired network issues .................................................................................................... 109
   Wireless network issues ................................................................................................. 109
   Mobile Printing issues .................................................................................................... 112
   Network configuration page ............................................................................................ 112

15 Troubleshooting general printer issues ............................................................................. 114
   Printer does not start ....................................................................................................... 115
   Printer does not print ...................................................................................................... 115
   Printer seems slow ......................................................................................................... 115
   Front panel is frozen ....................................................................................................... 116
   Cannot access the Embedded Web Server ...................................................................... 116
   Alerts ............................................................................................................................. 116

16 Front-panel error messages ............................................................................................... 117

17 HP Customer Care .......................................................................................................... 119
   Introduction .................................................................................................................... 120
   HP Professional Services ............................................................................................... 120
   HP Proactive Support .................................................................................................... 121
   Customer Self Repair .................................................................................................... 121
   Contact HP Support ....................................................................................................... 122
1 Introduction

- Safety precautions
- HP Start-Up Kit
- Using this guide
- Printer models
- Main features
- Main components
- Front panel
- Printer software
- Mobile Printing
- Turn the printer on and off
- The printer’s internal prints
Safety precautions

The following precautions ensure the proper use of the printer and prevent the printer from being damaged. Follow these precautions at all times:

● Use the power supply voltage specified on the label. Avoid overloading the printer's electrical outlet with multiple devices.

● Do not disassemble or repair the printer yourself. Contact your local HP Service Representative for service, see Contact HP Support on page 122.

● Use only the electrical cord supplied by HP with the printer. Do not damage, cut, or repair the power cord. A damaged power cord can cause fire or electric shock. Replace a damaged power cord with an HP-approved power cord.

● Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the printer. Doing so may cause fire, electric shock, or other serious hazards.

● Power off the printer and unplug the power cord from the power outlet in any of the following cases:
  – When placing your hands inside the printer
  – If there is smoke or an unusual smell coming from the printer
  – If the printer is making an unusual noise not heard during normal operation
  – A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts of the printer
  – During an electrical storm (thunder and lightning)
  – During a power failure

HP Start-Up Kit

The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer’s software and documentation.

Using this guide

This guide can be downloaded from the HP Support Center (see HP Support Center on page 120).

Introduction

This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance

These chapters help you carry out normal printer procedures; they include the following topics:

● Connecting the printer on page 12
● Setting up the printer on page 19
● Personalizing the printer on page 23
● Paper handling on page 29
● Printing on page 39
● Mobile Printing on page 40
• Practical printing examples on page 48
• Handling ink cartridges and printhead on page 64
• Maintaining the printer on page 68

Troubleshooting
These chapters help you solve problems that may occur while printing; they include the following topics:
• Troubleshooting paper issues on page 84
• Troubleshooting print-quality issues on page 94
• Troubleshooting ink cartridge and printhead issues on page 105
• Troubleshooting data communication issues on page 107
• Troubleshooting general printer issues on page 114
• Front-panel error messages on page 117

Accessories, support and specifications
These chapters, Accessories on page 79, HP Customer Care on page 119, and Printer specifications on page 123, contain reference information, including customer care, the printer specifications, and part numbers for paper types, ink supplies, and accessories.

Glossary
The Glossary on page 128 contains definitions of printing and HP terms used in this documentation.

Index
In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and cautions
The following symbols are used in this manual to ensure the proper use of the printer and to prevent the printer from being damaged. Follow the instructions marked with these symbols.

⚠️ WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or death.

⚠️ CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or damage to the printer.

Printer models
This guide covers the following printer models, normally referring to them by their short names for brevity.

<table>
<thead>
<tr>
<th>Full name</th>
<th>Short name</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet T120 24-in Printer</td>
<td>T120</td>
</tr>
<tr>
<td>HP DesignJet TS20 24-in Tabletop Printer</td>
<td>TS20-24T</td>
</tr>
<tr>
<td>HP DesignJet TS20 24-in Printer</td>
<td>TS20-24</td>
</tr>
<tr>
<td>HP DesignJet TS20 36-in Printer</td>
<td>TS20-36</td>
</tr>
</tbody>
</table>
Main features

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 610 mm (24 in) or 914 mm (36 in) wide. Some major features of the printer are shown below:

- Print resolution of up to 2400 × 1200 dpi (T520) or 1200 × 1200 dpi (T120), using the **Best** print-quality option, the **Maximum Detail** option and photo paper
- The printer can be controlled from its front panel or from a remote computer using the Embedded Web Server or the HP Utility

**NOTE:** Throughout this manual, “HP Utility” refers to the HP Utility for Mac OS X and the HP DesignJet Utility for Windows.

- Touch-sensitive front panel in color, with an intuitive graphical user interface
- Supports USB, Ethernet, or Wi-Fi connection
- Includes Mobile Printing and Web-connected features such as automatic firmware upgrades and HP ePrint
- Handles roll and cut-sheet paper, with a multi-sheet tray
- Color emulations, see Printer emulation on page 46
- Economode for printing economically
- Ink and paper usage information available from the Embedded Web Server, see Access the Embedded Web Server on page 24
- Supplies information, troubleshooting, and firmware updates available from the HP Utility, see Access the HP Utility on page 24
- Access to the online HP Support Center (see HP Support Center on page 120)
Main components

Front view (T520 except T520-24T)

1. Multi-sheet tray extenders
2. Top cover
3. Output tray extenders
4. Bin
5. Output platen
6. Ink cartridges
7. Ink cartridge cover
8. Front panel
9. Printhead carriage
10. Printhead
Rear view (T520 except T520-24T)

1. Roll cover
2. Communication ports
3. Power socket
4. Multi-sheet tray

Rear view (T120 and T520-24T)

1. Blue stop
2. Spindle
3. Paper roll
Communication ports

1. Hi-Speed USB device port, to connect a computer
2. Fast Ethernet port, to connect to a network

Front panel

The front panel is a touch-sensitive screen with a graphical user interface; it is located on the front left of the printer. It gives you complete control of your printer: from the front panel, you can print, view information about the printer, change printer settings, perform calibrations and tests, and so on. The front panel also displays alerts (warning and error messages) when needed.

The front panel has a large central area to display dynamic information and icons. On the left and right sides you can see up to six fixed icons at different times. Normally they are not all displayed at the same time.

To the right of the front panel is the power key, with which you can turn the printer on or off. The key is illuminated when the printer is on. It flashes when the printer is in transition between on and off.

Left and right fixed icons

- \[ \text{●} \] shows the status of the wireless connection: if the blue light is shining, the wireless connection is active.
- Tap \[ ✏️ \] to return to the home screen.
- Tap \[ ? \] to view help about the current screen.
• Tap ⬅️ to go to the previous item.
• Tap ➤️ to go to the next item.
• Tap ◀️ to go back to the previous screen.
• Tap ✗️ to cancel the current process.

**Home screen dynamic icons**

The following items are displayed only on the home screen:

• At the top left of the home screen is a message telling you which paper source is active.
• Tap 📦 to view Web Services status and display your printer’s email address.
• Tap 🌐 to view connectivity status information and to perform network configuration. If a network cable is connected, 🔗 is displayed instead.

**NOTE:** It is not possible to use wireless and wired network connections simultaneously.

• Tap 📐 to view ink information.
• Tap 🔧 to change printer settings.
• Tap 📀 to load, unload, and change options for roll paper.
• Tap 📀 to change options for the multi-sheet tray, or to activate it.
• Tap 📀 to load, unload, and change options for single sheets.

**NOTE:** The active paper source is indicated by a slightly larger icon, with a white tick in a green circle.

If the printer is left idle for some time, it goes into sleep mode and switches off the front-panel display. To change the time that elapses before sleep mode, tap ⌚️, then Printer preferences > Sleep. You can set a time between 5 and 240 minutes.

The printer wakes from sleep mode and switches on the front-panel display whenever there is some external interaction with it.

Information about specific uses of the front panel can be found throughout this guide.

**Printer software**

The following software is provided with your printer:

• The HP-GL/2 and HP RTL driver for Windows (T520 only)
• The PCL3GUI raster driver for Windows (T120 only)
• The PCL3GUI raster driver for Mac OS X
• HP DesignJet Preview
The Embedded Web Server allows you to:
- Manage the printer from a remote computer
- View the status of the ink cartridges, the printhead, and the paper
- Access the HP Support Center, see HP Support Center on page 120
- Update the printer’s firmware, see Firmware update on page 77
- Perform alignments and troubleshooting
- Change various printer settings
- Manage e-mail notifications

See Access the Embedded Web Server on page 24.

The HP Utility allows you to:
- Manage the printer from a remote computer
- View the status of the ink cartridges, the printhead, and the paper
- Access the HP Support Center, see HP Support Center on page 120
- Update the printer’s firmware, see Firmware update on page 77
- Launch the Embedded Web Server

See Access the HP Utility on page 24.

**NOTE:** New versions of all printer software can be expected to appear from time to time. In some cases, when you receive your printer there may already be later versions available on HP’s website of some of the software provided with it.

**Mobile Printing**

Your printer can be connected to the Internet and the Web, providing various benefits:
- Automatic firmware updates (see Firmware update on page 77)
- Print on HP printers from almost anywhere
- Print on HP printers from almost any device, including smartphones and tablet computers

To take advantage of these benefits, your printer must be connected to the Internet.

For the latest information, see [http://www.hpconnected.com](http://www.hpconnected.com).

With HP Mobile Printing Solutions you can print straight from your smartphone or tablet in just a few simple steps wherever you are, by using your mobile device OS or sending an email to your printer with a PDF attachment.

- iOS-Apple printing is enabled through Airprint.
- For Android printing, install the HP Print Service App from Google Play (if you do not have it already pre-installed in your mobile device).

For more information, see Mobile Printing on page 40 and [http://www.hp.com/go/designjetmobility](http://www.hp.com/go/designjetmobility).
Turn the printer on and off

If you wish to turn the printer on or off, the normal and recommended method is to use the power key on the front panel.

However, if you plan to store the printer for a long period or the power key does not seem to work, you are recommended to unplug the power cord.

To turn it back on, plug in the power cord.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the printhead. Preparing the printhead takes about 75 seconds.

**NOTE:** When the printer has not been used for a certain period of time (the default time is determined by Energy Star), it saves power by going into sleep mode. However, any interaction with the printer’s front-panel display, or sending a new job to print, returns it to active mode, and it can resume printing immediately. To change the sleep mode time, see Change the sleep mode setting on page 25.
The printer’s internal prints

The internal prints give various kinds of information about your printer. They can be requested from the front panel.

Before requesting any internal print, check that the printer and the paper are ready for printing. The loaded paper should be at least A4 portrait—210 mm (8.27 in) wide—otherwise the print may be clipped.

To print any internal print, tap \[\text{setting}^2\] then scroll down to \text{Internal prints} and tap it, then select the internal print you want. The following internal prints are available:

- **Demo prints** show some of the capabilities of the printer:
  - Print drawing demo
  - Print rendering demo
  - Print GIS map

- **User info prints**
  - Print printer-status report
  - Print print-quality report
  - Print network report
2 Connecting the printer

- Choose which connection method to use
- Connect the printer to your network
- Connect a computer to the printer by network (Windows)
- Connect a computer to the printer by USB cable (Windows)
- Connect a computer to the printer by network (Mac OS X)
- Connect a computer to the printer by USB cable (Mac OS X)
Choose which connection method to use

The following methods can be used to connect your printer.

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Speed</th>
<th>Cable length</th>
<th>Other factors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless</td>
<td>Moderate; varies according to conditions (distance to router, interference, number of wireless clients, network topology, etc.)</td>
<td>N/A</td>
<td>Sensitive to interference over longer distances; requires extra equipment (wireless access point or wireless router)</td>
</tr>
<tr>
<td>Fast Ethernet</td>
<td>Fast; varies according to network traffic</td>
<td>Long: 100 m (328 ft)</td>
<td>Requires extra equipment (switches)</td>
</tr>
<tr>
<td>Hi-Speed USB</td>
<td>Very fast</td>
<td>Short: 3 m (10 ft)</td>
<td>A certified Hi-Speed USB cable is necessary for reliable communication.</td>
</tr>
</tbody>
</table>

**NOTE:** The speed of any network connection depends on all components used in the network, which can include network interface cards, routers, switches and cables. If any one of these components cannot operate at high speed, you will have a low-speed connection. The speed of your network connection can also be affected by the total amount of traffic from other devices on the network.

Connect the printer to your network

The printer is able to configure itself automatically for most networks, in a similar way to any computer in the same network. The first time you connect it to a network, this process may take a few minutes.

Once the printer has a working network configuration, you can check its network address from the front panel: tap on the front panel.

To connect to a wireless network, the easiest way is to go to the front panel and tap on the front panel and tap Connectivity > Wireless setup wizard.

When a network device automatically configures itself by receiving an IP address from the DHCP service, this IP address may change from the last time the device is powered off to the next time it is powered on, which may lead to the device being shown as “offline” when driver port settings are configured with the original IP address. There are at least three possible ways to avoid this:

- Increase the lease time of your DHCP server device.
- Set a fixed IP address for your printer that will not be changed by DHCP (see Communication failures between computer and printer on page 108).
- Configure the printer and driver to refer to the hostname instead of the numeric IP address (see Communication failures between computer and printer on page 108).

See the Assembly Instructions for more details about Internet setup, and how to connect to and register with the cloud to enable Web Services.

Connect a computer to the printer by network (Windows)

The following instructions apply if you intend to print from software applications using a printer driver. See Printing on page 39 for alternative ways of printing.
Before you begin, check your equipment:

- The printer should be set up and on.
- The Ethernet switch or router should be on and functioning correctly.
- The printer and the computer should be connected to the network (see Connect the printer to your network on page 13). The printer can be connected by Ethernet or Wi-Fi.

Now you can proceed to install the printer software and connect to your printer.

**Printer software installation**

1. Make a note of the printer’s IP address from the front panel (see Access the Embedded Web Server on page 24).

2. Insert the HP Start-up Kit DVD into your computer. If the DVD does not start automatically, run the start.exe program in the root folder of the DVD.

   **NOTE:** You can also download the printer drivers from [http://www.hp.com/go/T120/software](http://www.hp.com/go/T120/software) or [http://www.hp.com/go/T520/software](http://www.hp.com/go/T520/software).

3. Click the Installation tab.

4. Click the Download button, which takes you to the product page, with the section Software and drivers already selected.

   If your computer fails to find any printers on the network, the Printer Not Found window is displayed, which helps you to try to find your printer. If you have a firewall in operation, you may have to disable it temporarily in order to find the printer. You also have the options of searching for the printer by its hostname, IP address, or MAC address.

   In some cases, when the printer is not in the same sub-net as the computer, specifying the printer’s IP address may be the only successful option.

5. Click the Go button to reach the download page. Your computer automatically reports your operating system.

6. Follow the instructions on your screen to install the printer drivers and other HP software, such as the HP Utility.

   If you have enabled Web Services on your printer, you can print to your printer by email. Just check the Web Services menu for the email address of your printer, then send the file you want to print to that email address as an attachment.

**Connect a computer to the printer by USB cable (Windows)**

You can connect your printer directly to a computer without going through a network, by using the printer's built-in Hi-Speed USB device port. A USB connection may be faster than a network connection, but it has some disadvantages that you should bear in mind:

- The cable is of limited length.
- It is more difficult to share the printer.
- You cannot use Web Services.
- You cannot use automatic firmware updates.

**NOTE:** The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementer's Forum ([http://www.usb.org/](http://www.usb.org/)) should be used with this printer.
Printer software installation

The following instructions apply if you intend to print from software applications using a printer driver. See Printing on page 39 for alternative ways of printing.

1. **Do not connect the computer to the printer yet.** You must first install the printer software on the computer, as follows.

2. Insert the *HP Start-up Kit* DVD into your DVD drive. If the DVD does not start automatically, run the `start.exe` program in the root folder of the DVD.

   **NOTE:** You can also download the printer drivers from [http://www.hp.com/go/T120/software](http://www.hp.com/go/T120/software) or [http://www.hp.com/go/T520/software](http://www.hp.com/go/T520/software).

3. Click the **Installation** tab.

4. Click the **Download** button, which takes you to the product page, with the section **Software and drivers** already selected.

5. Click the **Go** button to reach the download page. Your computer automatically reports your operating system.

6. In some cases, you may see a message warning you that the installer would need to communicate through the firewall in order to search the network for printers. As you have no need to do this, you can check the box **Continue installation without searching the network**.

7. If you see a list of networked printers, click **Help me find my printer (including network and USB connected printers)**.

8. Click **USB Cable**.

   **NOTE:** You can connect your printer and complete the installation later if you prefer. To do so, check the box marked **I want to connect my printer after completing the setup wizard**.

9. When prompted to do so, connect your computer to the printer with a certified USB cable. Ensure that the printer is turned on.

10. Follow the instructions on your screen to install the printer drivers and other HP software, such as the HP Utility.

11. If during the process you have not been prompted to connect the printer, connect the printer now, and let the wizard install the device automatically.

Printer sharing considerations

Any other users sharing your USB-connected printer will be able to send print jobs, but will not be able to receive information from the printer—which affects status reports, administration and troubleshooting.

**TIP:** The best way to share the printer over a network is to connect the printer not to any computer, but to the network. See Connect a computer to the printer by network (Windows) on page 13.

Connect a computer to the printer by network (Mac OS X)

You can connect your printer to a network under Mac OS X by using the following methods:

- Bonjour
- TCP/IP

The following instructions apply if you intend to print from software applications using a printer driver. See Printing on page 39 for alternative ways of printing.
Before you begin, check your equipment:

- The printer should be set up and on.
- The Ethernet switch or router should be on and functioning correctly.
- The printer and the computer should be connected to the (wired or wireless) network. See Connect the printer to your network on page 13.

Now you can proceed to install the printer software and connect to your printer.

**Bonjour connection**

1. Go to the front panel and tap or . Note the mDNS service name of your printer.
2. Insert the *HP Start-up Kit* DVD into your DVD drive.
3. Open the DVD icon on your desktop.
4. Open the *Mac OS X HP DesignJet Installer*.
5. Follow the instructions on your screen.
6. The printer software is installed, including the printer drivers and other HP software, such as the HP Utility.
   
   If you have enabled Web Services on your printer, you can print to your printer by email. Just check the Web Services menu for the email address of your printer, then send the file you want to print to that email address as an attachment.
7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your printer. Follow the instructions on your screen.
8. When you reach the Select Printer screen, look for your printer’s mDNS service name (which you noted in step 1) in the Printer Name column.
   
   - If you find the right name, scroll sideways if necessary to see the Connection Type column, and check that it shows *Bonjour*. Then highlight that line. Otherwise, continue searching further down the list.
   
   - If you cannot find your printer’s name with a *Bonjour* connection type, check the box *My printer is not in the list*.
   
   Click *Continue*.
9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click *Quit* to exit, or *Create New Queue* if you want to connect another printer to the network.
10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

   If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

**TCP/IP connection**

1. Go to the front panel and make a note of the printer’s URL (see Access the Embedded Web Server on page 24).
2. Insert the *HP Start-up Kit* DVD into your DVD drive.
3. Open the DVD icon on your desktop.
4. Open the *Mac OS X HP DesignJet Installer*.
5. Follow the instructions on your screen.
6. The printer software is installed, including the printer drivers and other HP software, such as the HP Utility. If you have enabled Web Services on your printer, you can print to your printer by email. Just check the Web Services menu for the email address of your printer, then send the file you want to print to that email address as an attachment.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your printer. Follow the instructions on your screen.

8. When you reach the Select Printer screen, look for your printer’s URL (which you noted in step 1) in the Printer Name column.
   - If you find the right name, scroll sideways if necessary to see the Connection Type column, and check that it shows IP Printing. Then highlight that line. Otherwise, continue searching further down the list.
   - If you cannot find your printer’s name with an IP Printing connection type, check the box My printer is not in the list. Click Continue.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click Quit to exit, or Create New Queue if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

Connect a computer to the printer by USB cable (Mac OS X)

You can connect your printer directly to a computer without going through a network, by using the printer’s built-in Hi-Speed USB device port. A USB connection may be faster than a network connection, but it has some disadvantages that you should bear in mind:

- The cable is of limited length.
- It is more difficult to share the printer.
- You cannot use Web Services.
- You cannot use automatic firmware updates.

**NOTE:** The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementor’s Forum (http://www.usb.org/) should be used with this printer.

Printer software installation

The following instructions apply if you intend to print from software applications using a printer driver. See Printing on page 39 for alternative ways of printing.

1. Make sure the printer is either turned off, or disconnected from the computer.
2. Insert the HP Start-up Kit DVD into your DVD drive.
3. Open the DVD icon on your desktop.
4. Open the Mac OS X HP DesignJet Installer.
5. Follow the instructions on your screen.
6. The printer software is installed, including the printer driver and the HP Utility.
7. Make sure that the printer is turned on and connected to the computer with a certified USB cable.
NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

8. Shortly afterwards, a print queue is created automatically for your printer.

Sharing the printer

If your computer is connected to a network, you can make your directly connected printer available to other computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.

2. To enable printer sharing, click Sharing, then Printer Sharing, and then check the printer(s) that you want to share.

3. Your printer now automatically appears in the list of shared printers displayed by any other computer running Mac OS X and connected to your local network.

Bear in mind the following considerations:

- Any other users wishing to share your printer must install the printer software on their own computers.
- Anyone sharing your directly connected printer will be able to send print jobs, but will not be able to receive information from the printer—which affects alerts, status reports, paper management, administration and troubleshooting.
- You may find that sharing your directly connected printer with other users will slow down your computer unacceptably.

TIP: The best way to share the printer over a network is to connect the printer not to any computer, but to the network. See Connect a computer to the printer by network (Mac OS X) on page 15.
3 Setting up the printer

- Introduction
- Automatic firmware update
- Turn email notifications on and off
- Turn alerts on and off
- Control access to the Embedded Web Server
- Set Windows driver preferences
- Set up Web Services and Mobile Printing
Introduction

This chapter describes various printer settings that the printer administrator may wish to control as soon as a new printer is assembled and ready for use.

Automatic firmware update

The printer can automatically check for a firmware update periodically (see Firmware update on page 77). Without an update, some Web Services may not be available. The Enable Web Services process includes the option to turn on automatic firmware updates from the printer's front panel or Embedded Web Server.

Turn email notifications on and off

In order to receive email notifications from the printer, you must have configured the email server. To configure the email server using the Embedded Web Server, click Settings > Email server, and fill in the following fields:

- **SMTP server**: The IP address or hostname of the outgoing mail server (SMTP) that will process all email messages from the printer. If the mail server requires authentication, email notifications will not work.

- **Printer email address**: Each email message sent by the printer must include a return address, which does not need to be a real, functional email address, but it should be unique, so that recipients of the message can identify the printer that sent it.

You can turn specific email notifications on or off by clicking Notifications from the Tools tab of the Embedded Web Server.

Turn alerts on and off

Printer alerts warn you when there is a printer problem that you can correct by taking action, or when one of your printing jobs changes its status. The alerts are displayed by the printer’s front panel, by the HP Utility, by the printer driver and by the Embedded Web Server.

You can change the alert settings in various ways to display all, some, or none of the available alerts.

To access alert settings under Windows

- Click Alert Settings in the Tools menu of the HP DesignJet Utility.
- Click Alert Settings in any alert page displayed by the HP DesignJet Utility.
- Right-click the system tray icon of the HP DesignJet Utility, and click Alert Settings.

In the Alert Settings window, you can use the Alerting slider to turn off alerts completely.

Alternatively, you can choose when, if ever, to display critical or non-critical alerts.
To access alert settings under Mac OS X

- Open HP Printer Monitor preferences, select your printer, and then Customize Alerts, so that you can set each individual alert to appear in specific cases and with a specific time interval.

You can turn off alerts completely by unchecking the “Show monitor status in menu bar” box in the Notifications tab of the HP Printer Monitor preferences. If you leave that box checked but uncheck the “Notify me when alert appears” box (as below), the alerts will be available in the HP Printer Monitor, but will not pop up in the Dock screen.

Control access to the Embedded Web Server

To prevent users from modifying important device settings, you can set a password in the Embedded Web Server, so that users without the password can see only the Information tabs. Once set, the password is required to view or change any parameters in the other tabs.

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for instance to set color emulation or paper-saving options. To do this under Windows 7, for example, click the Start button on your computer’s screen, then click Devices and printers, then right-click your printer’s icon and click Printing preferences. Any settings you change in the Printing Preferences window will be saved as default values.
Set up Web Services and Mobile Printing

1. Make sure that your printer is correctly connected to the Internet.

2. Enable Web Services during initial setup of the printer, or later by tapping on the home screen and following the instructions on the front panel. The printer may need to restart if it has updated its firmware.

3. Optional step: Activate your account by clicking the activation link that you will receive by email. If you don’t see the message, remember to check your junk email folder.

4. Optional step: If you are the printer administrator, log in at HP Connected (http://www.hpconnected.com) to customize your printer’s email address or manage printer security for remote printing.

Congratulations, you have completed Web Services setup, and you can benefit from automatic firmware updates.

For the latest HP Connected information, support, and terms of use, see http://www.hpconnected.com.

For more information, see http://www.hp.com/go/designjetmobility.
4 Personalizing the printer

- Change the language of the front-panel display
- Access the Embedded Web Server
- Change the language of the Embedded Web Server
- Access the HP Utility
- Change the language of the HP Utility
- Change the sleep mode setting
- Change the auto-off setting
- Change the front-panel display brightness
- Configure network settings
- Manage printer security
- Change your printer’s email address
Change the language of the front-panel display

There are two possible ways to change the language of the front-panel menus and messages:

- If you can understand the current front-panel display language, tap ![printer settings icon] then **Printer preferences > Select language**.

- If you cannot understand the current front-panel display language, start with the printer powered off. Press the power key to turn it on. When you see icons appear on the front panel, tap ![printer settings icon], then ![printer settings icon], then ![printer settings icon]. If you cannot see those icons on the front panel, tap where they should appear (see **Front panel on page 7**).

Whichever method you used, the language selection menu should now appear on the front-panel display. Tap your preferred language.

Access the Embedded Web Server

The Embedded Web Server enables you to manage your printer remotely using an ordinary Web browser running on any computer.

To access the Embedded Web Server, you must have a TCP/IP connection to your printer. You can access the Embedded Web Server indirectly through the HP Utility, if you connect to your printer with a TCP/IP connection (wired or wireless).

The following browsers are known to be compatible with the Embedded Web Server:

- Internet Explorer 7 and later
- Opera 8 and later
- Mozilla Firefox 2 and later
- Safari 3 and later
- Google Chrome 3 and later

To access the Embedded Web Server on any computer, open your Web browser and type the IP address of your printer.

You can see your printer’s IP address on the front panel by tapping ![printer settings icon] or ![printer settings icon].

If you have followed these instructions but failed to get through to the Embedded Web Server, see **Cannot access the Embedded Web Server on page 116**.

Change the language of the Embedded Web Server

The default language in which the Embedded Web Server first appears is the language you have selected for your browser. If this language is not supported by the Embedded Web Server, the Embedded Web Server will appear in English; however, you can change it to any supported language.

The languages supported by the Embedded Web Server are English, Portuguese, Spanish, French, Italian, German, Polish, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese. There is a tab at the top right of the window to select language.

Access the HP Utility

The HP Utility enables you to manage your printer from a computer with a USB, TCP/IP, or Wi-Fi connection.
Under Windows, start the HP Utility from your desktop shortcut or from Start > All Programs > HP > HP DesignJet Utility > HP DesignJet Utility. This launches the HP DesignJet Utility, showing the HP DesignJet printers installed on your computer.

Under Mac OS X, launch the HP Utility from your dock shortcut or by clicking STARTUP_DISK > Library > Printers > HP > Utilities > HP Utility. This launches the HP Utility, showing the HP DesignJet printers installed on your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific to that printer.

Change the language of the HP Utility

The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows only), French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.

Under Windows, the language will be adjusted to your regional language settings as defined in the Windows Control Panel.

Under Mac OS X, the language is changed as for any other application. In System Preferences, click International and re-launch the application.

Change the sleep mode setting

If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep mode to save power. To change the time the printer waits before it goes into sleep mode, go to the front panel and tap , then Printer preferences > Sleep. Select the wait time you want and then tap OK. You can set the time from 5 to 240 minutes. The default time is 30 minutes.

Change the auto-off setting

You can use the printer’s auto-off feature to turn the printer off automatically. For example, setting it to 2 hours would turn the printer off after 2 hours of inactivity. In this way, you can save more energy. However, the auto-off feature is automatically disabled when the printer is connected to a network, to avoid inconveniencing network users.

If you are using a USB connection, you can set the printer to turn itself off completely after 2 to 12 hours of inactivity. At the front panel, tap , then Printer preferences > Auto-off.

Change the front-panel display brightness

To change the brightness of the front-panel display, tap , then Printer preferences > Display brightness, and select a value you want. Tap OK to set the value. The default brightness is set to 50.
Configure network settings

You can view and configure the network settings from the Embedded Web Server, the HP Utility or the front panel:

- From the Embedded Web Server: Click the **Setup** tab, then **Networking**.
- From the HP Utility: You can access the Embedded Web Server through the HP Utility.
- From the front panel: Tap **Connectivity**.

The following options are available:

- **Enable/Disable wireless** turns the wireless connection on or off.
- **Wireless setup wizard** provides an easy way to connect to a wireless network.
- **Wi-Fi protected setup** allows you to set up a connection with a wireless network using WPS (pushbutton or pin) encryption.
- **Network summary** displays information about the wired or wireless network.
- **Print wireless network test** runs diagnostic tests of wireless connectivity.
- **Print network configuration**
- **Advanced setup**
  - **Select I/O timeout** sets the time that the printer will wait for the driver to send a job to the printer once the connection has been opened. Values range from half a minute to half an hour.
  - **Link speed** sets the speed at which data are transmitted over the network. The default is **Automatic**.
  - **IP settings** allows you to view or change the IP address, subnet mask, default gateway, and DNS address.
  - **Hostname** allows you to change the hostname.
- **Restore network defaults**

Configure firewall settings

Firewall features provide network-layer security on both IPv4 and IPv6 networks. The firewall provides simple control of IP addresses that are allowed access.

**NOTE:** In addition to firewall protection at the network layer, the printer also supports open secure sockets layer (SSL) standards at the transport layer for secure client-server applications, such as client-server authentication or HTTPS Web browsing.

For firewall operation on the printer, you must configure a firewall policy to apply to specified IP traffic. Firewall policy pages are accessed through the Embedded Web Server and displayed by your Web browser. After a policy is configured, it is not activated until you click **Apply** in the Embedded Web Server.

Creating and using firewall rules

Firewall rules allow you to control IP traffic. Use firewall rules to allow or drop IP traffic based on IP addresses and services.

Enter up to ten rules, each rule specifying the host addresses, services, and the action to take for those addresses and services.
Create a firewall rule

1. Open the Embedded Web Server.
2. Click the Settings tab, then Firewall Rules.
3. Click New, and then follow the onscreen instructions.

**NOTE:** After you click Apply, the connection to the Embedded Web Server might be temporarily disrupted for a short period of time. If the IP address was unchanged, the Embedded Web Server connection will be enabled again. However, if the IP address was changed, use the new IP address to open the Embedded Web Server.

Change the priority of firewall rules

1. Open the Embedded Web Server.
2. Click the Settings tab, then Firewall Rules Priority.
3. Select the priority from the Rule Precedence list, with 10 having the highest priority and 1 having the lowest priority.
4. Click Apply.

Change firewall options

1. Open the Embedded Web Server.
2. Click the Settings tab, then Firewall Options.
3. Change whatever options you wish, then click Apply.

**NOTE:** After you click Apply, the connection to the Embedded Web Server might be temporarily disrupted for a short period of time. If the IP address was unchanged, the Embedded Web Server connection will be enabled again. However, if the IP address was changed, use the new IP address to open the Embedded Web Server.

Reset firewall settings

To reset the firewall settings to the factory defaults, restore the printer’s network settings.

Limitations to rules, templates, and services

When creating firewall rules, note the following limitations to rules, templates, and services.

<table>
<thead>
<tr>
<th>Item</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of rules</td>
<td>10 (one default rule)</td>
</tr>
<tr>
<td>Maximum number of Address Templates</td>
<td>12</td>
</tr>
<tr>
<td>Maximum number of user-defined address templates</td>
<td>5</td>
</tr>
<tr>
<td>Maximum number of services you can add to a user-defined service template</td>
<td>40</td>
</tr>
<tr>
<td><strong>NOTE:</strong> The predefined All Services template is not subject to this limitation and includes all services supported by the print server.</td>
<td></td>
</tr>
<tr>
<td>Maximum number of services you can add to the policy</td>
<td>40</td>
</tr>
<tr>
<td><strong>NOTE:</strong> For a given rule, only one address template and one service template can be added.</td>
<td></td>
</tr>
<tr>
<td>Maximum number of service templates in the policy</td>
<td>10</td>
</tr>
<tr>
<td>Maximum number of user-defined custom service templates</td>
<td>5</td>
</tr>
</tbody>
</table>
Reset network settings

To reset the administrator password and network settings, go to the front panel and tap then Connectivity > Restore network defaults.

NOTE: Print the network configuration page and check that the network settings have been reset.

NOTE: Resetting the printer's network settings also resets the printer's firewall settings.

Manage printer security

When you have set up Web Services, the printer is in unlock mode. In unlock mode, anyone who knows your printer's email address can print to your printer by just sending a file to it. Although HP provides a spam filtering service, you should be careful about giving out your printer's email address, as everything sent to that address may be printed on your printer.

If you are the printer administrator, you can manage printer security or change your printer status to lock mode by visiting HP Connected at http://www.hpconnected.com (availability varies by product, country, and region). You can also customize your printer's e-mail address and manage print jobs from there. On your first visit, you will need to create an account at HP Connected.

Change your printer’s email address

You can change your printer’s email address at HP Connected: http://www.hpconnected.com (availability varies by product, country, and region).
5 Paper handling

- General paper-loading advice
- Load a roll onto the spindle
- Load a roll into the printer
- Unload a roll
- Load a single sheet
- Unload a single sheet
- Use the multi-sheet tray
- View information about the paper
- Maintain paper
- Change the drying time
- Turn the automatic cutter on and off
- Form feed with or without cutting
General paper-loading advice

You can load paper into the printer in three different ways: from a roll, as a single sheet, or as a stack of single sheets from the multi-sheet tray. Only one of these methods can be used at a time, and switching from one to another is manual: it is not done automatically.

⚠️ CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

⚠️ CAUTION: All paper must be 280 mm (11 in) or wider. A4 and letter paper should not be loaded in landscape orientation.

🌟 TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

⚠️ CAUTION: Keep the bin closed throughout the loading process.

Load a roll onto the spindle

1. If your printer is a T520, open the roll cover.
2. Remove the spindle from the printer.

⚠️ **WARNING!** Do not insert your fingers into the spindle supports during the removal process.

3. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper stop from the end of the spindle.

4. If the roll is long, rest the spindle horizontally on a table and load the roll on the table.

5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing the correct orientation.

**NOTE:** From the back of the printer, the blue stopper is inserted into the right-side holder.

Ensure both ends of the roll are as close to the spindle stops as possible.
6. Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

![Diagram of paper stop](image1)

7. Ensure the blue paper stop is pushed in as far as it goes. Check that there is no space between the roll and the stops at both ends.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of different paper types on different spindles. Extra spindles are available for purchase, see Accessories on page 79.

**Load a roll into the printer**

To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle on page 30.

1. From the front panel, tap ![Loader Icon](image2), then Load roll.

   This step is optional: if you just start feeding in roll paper, the printer recognizes that you want to load a roll.

2. If your printer is a T520, open the roll cover.

3. Insert the spindle into the printer, holding it by both ends. The blue hub should be on the left, as viewed from the front of the printer.
4. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull the paper slightly and cut a straight edge.

5. Insert the edge of the paper into the printer.

   **WARNING!** Do not push your fingers inside the printer's paper path.

6. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer detects the paper, it beeps, and feeds in the paper automatically.

7. The front panel prompts you to select the paper category and type.

   ![Paper Type Selection](image)

   If you do not see your paper type in the front panel, tap **More paper types**. If you still cannot find your paper type in the whole list, see Paper type is not in the driver on page 87.

8. The printer checks the alignment and measures the width. If the roll is not correctly aligned, follow the instructions on the front-panel display.

9. If your printer is a T520, close the roll cover.

   **NOTE:** If you have an unexpected issue at any stage of the paper loading process, see Paper cannot be loaded successfully on page 85.
Unload a roll

If there is paper on the roll, you can unload it from the front panel: tap , then Unload roll. Afterwards, the multi-sheet tray will become the default active paper source.

If the end of the paper is no longer attached to the core, the front panel asks you to unload the roll manually. After unloading, the multi-sheet tray is the default active paper source.

Load a single sheet

**NOTE:** Roll paper and single sheets use the same input slot in the printer.

**NOTE:** Sheets of width 329 mm (12.95 in) or less should be loaded from the multi-sheet tray.

1. At the front panel, tap then Load single sheet.
2. If a roll is already loaded, you have to wait while it is automatically unloaded.
3. Select your paper category and type. If you do not see your paper type in the front panel, tap More paper types. If you still cannot find your paper type in the whole list, see Paper type is not in the driver on page 87.
4. If your printer is a T520, open the roll cover.

5. When prompted by the front panel, insert the sheet into the right-hand side of the input slot.

⚠️ **WARNING!** Do not push your fingers inside the printer’s paper path.
6. Align the sheet with the blue line.

7. Tap OK on the front panel to feed the paper into the printer. Guide the sheet into the printer; this is especially important with thicker papers.

8. The printer checks the alignment and measures the sheet.

**NOTE:** Depending on the width of the sheet, it feeds out the front of the printer.

9. If the sheet is not correctly aligned, you may be asked to reload it.

**NOTE:** If you have an unexpected problem at any stage of the paper loading process, see Paper cannot be loaded successfully on page 85.

**Unload a single sheet**

To unload a sheet, go to the front panel and tap then **Unload single sheet**.

The sheet unloads out of the front of the printer; either catch it manually or allow it to fall into the bin.

After unloading, the multi-sheet tray is the default active paper source.

**Use the multi-sheet tray**

1. If no roll is loaded or the roll has run out of paper, the multi-sheet tray is active by default.

   Alternatively, at the front panel, tap then **Use multi-sheet tray**. If a roll or single sheet is already loaded, you have to wait while it is automatically unloaded.

2. Adjust the input tray extensions depending on the length of the paper: the first extension for A4 and the second extension for A3 paper.
3. Adjust the output tray extensions depending on the length of the paper.

4. Load sheets of paper into the tray with the printed side facing outwards. Ensure that the sheets are all of the same size.

5. Adjust the tray to fit the width of the paper.
View information about the paper

To view the loaded paper information, tap the icon of the active paper source.

The following information is displayed on the front panel:

- Paper type you have selected
- Roll or sheet status
- Width of the paper in millimeters (estimated)

If no roll and no single-sheet paper is loaded, the message **Out of paper** is displayed.

Maintain paper

To maintain paper quality, follow the recommendations below:

- Store rolls covered by another piece of paper or cloth
- Store cut sheets covered and clean or brush them before loading them in the printer
- Clean input and output platens
- Always keep the top cover of your printer closed

**NOTE:** Photo and coated paper requires careful handling, see **Print is scuffed or scratched on page 100.**

Change the drying time

You may wish to change the drying time setting to suit special printing conditions such as multiple prints where time is of higher importance or when you need to be sure ink is dry before handling.

Tap \[ \text{ } \] then **Printer preferences > Print retrieval > Select drying time.** You can select:

- **Extended,** to set a longer than recommended time to ensure ink is completely dry
- **Optimized,** to set the default and recommended time for your selected paper (this is the default setting)
- **None,** to disable the drying time and remove your print as soon as it finishes printing

**CAUTION:** If the ink is not dry when the print is removed it could leave ink in the output tray and marks on the print.

**NOTE:** If you cancel the drying time during a print, the printer may not feed and cut the paper right away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper and then performs the printhead maintenance. However, if the dry time is greater than zero, the printer does not cut the paper until after the printhead maintenance has completed.

Turn the automatic cutter on and off

To turn the printer's paper cutter on or off, go to the front panel and tap \[ \text{ } \] then **Printer preferences > Print retrieval > Enable cutter** and change the cutter option.

The default setting is **On.**

**NOTE:** If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper on loading and unloading rolls.
**TIP:** To cut roll paper while the automatic cutter is disabled, see Form feed with or without cutting on page 38.

---

### Form feed with or without cutting

If you go to the front panel and tap ![button](image) then **Form feed and cut**, the printer advances the paper and makes a straight cut across the front edge. There are at least two possible reasons why you might want to do this:

- To trim the leading edge of the paper if it is damaged or not straight.
- To feed and cut the paper when the automatic cutter has been disabled.

**NOTE:** The printhead is serviced after each print, and the paper cannot be cut until the process completes, so you may notice a delay.

**CAUTION:** Remove the cut piece from the output platen. If strips or short prints are left on the output platen, the printer could jam. Check also that there are no pieces of paper in the cutter guide.

---

**NOTE:** Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 100.

To advance the paper without cutting it, go to the front panel and tap ![button](image) then **Form feed**.
6  Printing

- Mobile Printing
  - Print from mobile devices
  - Print by email (HP ePrint)
- Print with HP Click
- Printing from a computer using a printer driver
  - Advanced print settings
  - Color management
Mobile Printing

You can print to your printer from many mobile devices and from almost any location. There are two main methods of Mobile Printing:

- Direct printing by connection to the same network
- Printing by e-mail

Print from mobile devices

You can print directly from the operating system of your mobile device, if your mobile device and printer are connected to the same network.

For more information, see http://www.hp.com/go/designjetmobility.

Print from Apple iOS

iOS printing is enabled through Airprint. You must have iOS 7.0 or later.

1. Open the document or photo you want to print, and tap the Share button.
2. Swipe the screen to reveal the Print button, and tap it.
3. Check the print settings, then tap Print.

Print from Android

For Android printing, install and enable the HP Print Service App from Google Play (https://play.google.com/store/apps/details?id=com.hp.android.printservice&hl=en), if it is not already installed in your device. You must have Android KitKat 4.4 or later.

1. Open the document or photo you want to print, and tap the menu icon, then Print.
2. Choose your printer from the list.
3. Check the print settings, then tap Print.

Print from Apple iOS or Android with All-in-One Remote


1. Open the document or photo you want to print, tap the Share button, and select AiO.
2. Open it in All-in-One Remote. Go to Settings to adjust the print quality or color mode if necessary.
3. Check the print settings, then tap Print.

Print by email (HP ePrint)

After you have enabled Web Services in the printer (see Set up Web Services and Mobile Printing on page 22), you can print to that printer by email. Just check the Web Services menu or the ePrint menu for the email address of your printer, then send the file you want to print to that email address as an attachment.
In this way, you can print from anywhere with an Internet connection and email capability, without needing any printer driver. There are a few constraints that you should bear in mind:

- The attached files to be printed must be in PDF, JPEG, or TIFF formats.
- The maximum file size is 10 MB, but your email server may have a lower limit.
- Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally in portrait orientation (some printers may offer autorotation).

For more information, see https://www.hpconnected.com.

Print with HP Click

You can use HP Click to print a TIFF, JPEG, HP-GL/2, or PDF file directly from a computer connected to the printer. See http://www.hp.com/go/clickDesignJet.

Printing from a computer using a printer driver

This is the traditional way of printing from a computer. The correct printer driver must be installed on the computer (see Connecting the printer on page 12), and the computer must be connected to the printer by network or USB cable.

When the printer driver has been installed and the computer is connected to the printer, you can print from a software application by using the application’s own Print command and selecting the correct printer.

Advanced print settings

The rest of this chapter explains the various print settings that you can use. These methods offer a relatively large number of settings in order to satisfy all requirements.

**TIP:** In general you are recommended to use the default settings unless you know that they do not meet your requirements.

**TIP:** If you intend to reuse a particular group of settings repeatedly, you can save those settings under a name of your own choice and recall them later. A saved group of settings is known as a ‘quick set’ in the Windows printer driver.

Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed, while fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and speed. With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal, and Fast. If you select Fast, you can also select Economode, which uses a lower rendering resolution and consumes less ink. It therefore increases printing speed even further, but reduces print quality. Economode can be selected only from the custom options (not from the slider).

There is also a supplementary custom option that may have an effect on print quality: Maximum detail. See High-quality printing on page 45.

**NOTE:** In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom Print Quality Options dialog box (click Custom options and then Settings). In the Mac OS X Print dialog, it is displayed in the Summary panel.
You can select print-quality options in the following ways:

- **In the Windows driver dialog:** Click the Paper/Quality tab and look at the Print Quality section. If you click Standard Options, you will see a simple slider with which you can select speed or quality. If you select Custom Options, you will see the more specific options described above.

- **In the Mac OS X Print dialog:** Click the Paper/Quality panel and look at the Quality Options section. If you select Standard quality options, you will see a simple slider with which you can select speed or quality. If you select Custom quality options, you will see the more specific options described above.

**NOTE:** You cannot change the print quality of pages that the printer is already receiving or has already received (even if they have not started to print yet).

### Select paper size

The paper size can be specified in the following ways.

**NOTE:** The paper size specified here should be the paper size in which the document was created. It is possible to rescale the document to a different size for printing. See Rescale a print on page 44.

- **In the Windows driver dialog:** Click the Paper/Quality tab, then select your paper size from the Document Size list.

- **In the Mac OS X Page Setup dialog:** Select your printer from the Printer list, then select your paper size from the Paper Size list.

**NOTE:** If your application offers no Page Setup dialog, use the Print dialog.

### Custom paper sizes

If you want to choose a paper size that is not included in the list of standard paper sizes, there are various different ways to specify it.

#### Use the Windows printer driver

1. Click the Paper/Quality tab.
2. Click the Custom button.
3. Enter the name and dimensions of your new paper size.
4. Click OK. The new paper size is automatically selected.

A custom paper size created in this way has the following characteristics:

- The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.
- The paper size is local to the printer queue. It will not be seen from other printer queues in the same computer.
- In Domain server networks, the paper size is local to the computer. It will not be seen from other computers sharing the printer queue.
- In Workgroup networks, the paper size will be shared among all the computers sharing the printer queue.
- If the printer queue is deleted, the paper size is deleted with it.
Use Windows forms

1. Windows Vista or XP: From the Start menu, or from the Control Panel, click **Printers**; then, from the **File** menu, click **Server Properties**.
   
   Windows 7: From the Start menu, or from the Control Panel, click **Devices and Printers**, then **Select Printer**.

2. In the **Forms** tab, check the **Create a new form** box.

3. Enter the name and dimensions of your new paper size. Leave the margins as 0.00.

4. Click the **Save Form** button.

5. Go to the printer driver, and click the **Paper/Quality** tab.

6. Select **More...** from the drop-down list of paper sizes.

7. Select your new paper size from the group of Custom sizes.

A custom paper size created in this way has the following characteristics:

- The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.
- Restricted users cannot create paper forms. The “manage documents” role in the Windows Active Directory is the minimum required.
- The paper size is local to the computer. It will be seen in all the printer queues that have been created on the computer and that support paper of that size.
- If a printer queue is shared, this paper size will appear in all the client computers.
- If a printer queue is shared from another computer, this paper size will not appear on the driver’s document size list. A Windows form in a shared queue needs to be created in the server.
- If the printer queue is deleted, the paper size is not deleted.

Use the Mac OS X printer driver

1. Go to the **Page Setup** dialog.
   
   **NOTE:** If your application offers no **Page Setup** dialog, use the **Print** dialog.

2. Click **Paper Size > Manage Custom Sizes**.

Select margins options

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the paper. However, you can change this behavior in the following ways:

- In the **Windows** driver dialog: Click the **Paper/Quality** tab and then the **Margins/Layout** button.
- In the **Mac OS X** Print dialog: Click the **Margins/Layout** panel.

You will then see at least some of the following options.

**NOTE:** Under Mac OS X, the available margins options depend on the paper size selected.
- **Standard.** Your image will be printed on a page of the size you have selected, with the default margin between the edges of the image and the edges of the paper. The image should be small enough to fit between the margins.

- **Oversize.** You should load paper that is larger than the size you selected in the application or driver. If you cut off the margins after printing, you will be left with a page of the size you selected, with no margins remaining between your image and the edges of the paper. This is useful when you want your image to cover the whole area of the paper.

- **Clip Contents By Margins.** Your image will be printed on a page of the size you have selected, with the default margin between the edges of the image and the edges of the paper. In this case, if the image is the same size as the page, the printer assumes that the extreme edges of the image are either white or unimportant, and do not need to be printed. This may be useful when your image already contains a border.

**Print on loaded paper**

To print a job on whichever paper is loaded in the printer, select Any in the Paper Type option of your printer driver.

- **In the Windows driver dialog:** Click the Paper/Quality tab, then select Any in the Paper Type drop-down list.
- **In the Mac OS X Print dialog:** Click the Paper/Quality panel, then select Any in the Paper Type drop-down list.

**NOTE:** Any is the default Paper Type selection.

**Rescale a print**

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally larger). This may be useful:

- If your software does not support large formats
- If your file is too large for the printer’s memory—in this case, you can reduce the paper size in your software and then scale it up again using the front-panel option

You can rescale an image in the following ways:

- **In the Windows driver dialog:** Click the Features tab and look at the Resizing Options section.
  
  - The Print document on option adjusts the image size to the paper size you have selected. For example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.
  
  - The % of actual size option enlarges the printable area of the original paper size (the page minus the margins) by the percentage indicated, then adds the margins to create the output paper size.

- **In the Mac OS X Print dialog:** Click the Paper Handling panel, then Scale to fit paper size, and select the paper size to which you want to scale the image. If you want to increase the size of the image, make sure that the Scale down only box is unchecked.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise the image will be clipped.
Print a draft

You can specify fast draft-quality printing in the following ways:

- **In the Windows driver dialog:** Click the Paper/Quality tab and look at the Print Quality section. Move the print-quality slider to the extreme left (‘Speed’).
- **In the Mac OS X Print dialog:** Click the Paper/Quality panel and move the print-quality slider to the extreme left (‘Speed’).

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for documents containing only text and line drawings:

- **In the Windows driver dialog:** Click the Paper/Quality tab and look at the Print Quality section. Click Custom Options, then set the quality level to Fast and check the Economode box.
- **In the Mac OS X Print dialog:** Click the Paper/Quality panel and set the quality options to Custom, then set quality to Fast and check the Economode box.

High-quality printing

You can specify high-quality printing in the following ways:

- **In the Windows driver dialog:** Click the Paper/Quality tab and look at the Print Quality section. Move the print-quality slider to the extreme right (‘Quality’).
- **In the Mac OS X Print dialog:** Click the Paper/Quality panel and move the print-quality slider to the extreme right (‘Quality’).

If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print Quality Options box under Windows), print sharpness may be improved by selecting the Maximum Detail option. This option is available only if you are printing on glossy paper and you have selected Best print quality.

- **In the driver dialog (Mac OS X Print dialog):** Select Custom instead of Standard print-quality options, then check the Maximum Detail box.

**NOTE:** The Maximum Detail option results in slower printing with photo papers, but it does not increase the amount of ink used.

Use paper economically

You may be able to save some roll paper by using the following options:

- **In the Windows driver dialog:** Click the Features tab and then Remove top/bottom blank areas and/or Rotate by 90 degrees or Autorotate.
- **In the Mac OS X Print dialog:** Click the Finishing panel, then Remove Top/Bottom Blank Areas.

Use ink economically

Here are some recommendations for making economical use of ink:

- For draft prints, use plain paper and move the print-quality slider to the left end of the scale (‘Speed’). For further economy, select custom print quality options, then select Fast and Economode.
- Clean the printhead only when needed. Cleaning the printhead can be useful, but it uses a small amount of ink.
Leave the printer permanently turned on so that it can maintain the printhead in good condition automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not done, the printer may need to use much more ink later to restore the health of the printhead.

Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some ink, and its frequency is related to the number of passes made by the printhead.

Color management

Your printer has been engineered with advanced hardware and software features to ensure predictable and dependable color results:

- State-of-the-art HP printheads and HP inks
- Dedicated color resources for most available paper types
- Color emulation of other HP DesignJet printers

Color management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when you print an image, you see very similar colors as when you view the same image on your monitor. Color management is highly dependent on the paper type loaded at the printer, so take care to select the correct preset for the paper type you are using.

The color management options for your printer can be selected from the Color menu in the Windows driver dialog or from the Color Options panel in the Mac OS X Print dialog. In some applications you can make the choice in the application itself. Consult the HP Support Center for guidance on how to use the color management options of your particular application.

- **Application-Managed Colors**: In this case your application program must convert the colors of your image to the color space of your printer and paper type, using the ICC profile embedded in the image and the ICC profile of your printer and paper type.

- **Printer-Managed Colors**: In this case your application program sends your image to the printer without any color conversion, and the printer converts the colors to its own color space. The color management in the printer is done using a set of stored color tables. ICC profiles are not used. This method can produce very good results with supported HP paper types. There are two color spaces that the printer can convert to its own color space using the stored color tables: sRGB and Adobe RGB.

  - **sRGB**: emulates the characteristics of the average computer monitor. This standard space is endorsed by many hardware and software manufacturers, and has become the default color space for many scanners, cameras, printers, and software applications.

  - **Adobe RGB**: provides a larger color gamut than sRGB. Use this space if you need to do print production work with a wide range of colors.

Printer emulation

If you want to print a particular job and to see approximately the same colors that you would get from printing the same job on a different HP DesignJet printer, you can use the emulation mode provided by your printer.

**NOTE:** Printer emulation is available only when printing an HP-GL/2 job on plain or coated paper. It is not available from Mac OS X.

In the Windows HP-GL/2 driver dialog, click the Color tab, then Printer Managed Colors, then select Printer Emulation from the Source Profile list. You can then select from the Emulated Printer list.
Printing in grayscale or black-and-white

You can convert all colors in your image to shades of gray in the following ways:

- **In your application program**: Many applications provide this option.

- **In the Windows driver dialog**: Click the Color tab and look at the Color Options section. Click **Print in Grayscale**. Only the black ink will be used for printing, except if the paper loaded is glossy, in which case colored inks are used to compose the gray shades. You can also select **Print in pure black and white** if you want only black and white output with no gray shades. In this case, only black ink will be used for printing. The **Print in pure black and white** option is not supported when printing on glossy paper.

- **In the Mac OS X Print dialog**: Click the Color Options panel and select **Grayscale** from the Mode drop-down list. Only the black ink will be used for printing, except if the paper loaded is glossy, in which case colored inks are used to compose the gray shades. You can also select **Print in pure black and white** if you want only black and white output with no gray shades. In this case, only black ink will be used for printing. The **Print in pure black and white** option is not supported when printing on glossy paper.
7 Practical printing examples

- Print from Adobe Acrobat
- Print from Autodesk AutoCAD
  - Using printer emulation (TS20 only)
  - Using clip contents by margins
- Print from Adobe Photoshop
- Print and scale from Microsoft Office
  - Using PowerPoint
  - Using Project
  - Using Excel
Print from Adobe Acrobat

1. In the Acrobat window, move the mouse cursor to the bottom left corner of the document pane until the document size appears there.

2. Click File > Print and ensure that Page Scaling is set to None.

   NOTE: The page size will not be automatically selected according to the document size.
3. Click the **Properties** button and then the **Paper/Quality** tab.

![Properties Tab](image1)

4. Choose whatever **Document Size** and **Print Quality** you want to use. If you want to define a new custom paper size, click the **Custom** button.

![Custom Paper Size](image2)
5. Click the **Features** tab, and then **Autorotate**.

![Image of HP Designjet T120 Properties dialog box with autorotate option selected]

6. Click **OK**, and check that the print preview in the Print dialog box seems correct.

![Image of Print dialog box showing print preview]

**Print from Autodesk AutoCAD**

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.
2. Click the Plot icon at the top of the window.

3. The Plot window opens.

4. You can see further options by clicking the circular button in the lower right corner of the window.

**NOTE:** The Quality option here does not refer to the final print quality but to the quality of AutoCAD viewport objects that are sent for printing.
5. Click the **Properties** button.

6. Click the **Device and Document Settings** tab, then the **Custom Properties** button.

7. In the **Paper/Quality** tab, select the paper type that you intend to use.

8. Select the print quality (your own choice between speed and quality of printing).
9. If you intend to print on roll paper, you must decide where the printer should cut the paper. Click the **Margins/Layout** button, then **Clip contents by margins**.

10. Click the **Features** tab, then the **Autorotate** option. Autorotation can help to avoid wasting paper.

11. Click the **OK** button and save your configuration changes to a PC3 file.
12. If you have the HP DesignJet software suite installed, you will see a preview of the file you want to print.

Using printer emulation (T520 only)

Printer emulation can be requested by clicking Advanced settings > Color > Color management > Printer Managed Colors > Printer emulation.

You can select Off (no printer emulation) or the name of the printer model that you want to emulate.

This setting will apply to jobs that do not contain any printer emulation setting saved in the job.

Using clip contents by margins

You can select this option from Advanced settings > Paper/Quality > Margins/Layout > Print with margins > Layout > Clip contents by margins.

Use this option when the contents to be printed have white borders and a size equal to that of the paper you have selected. The printer will use the white border for its margins and you will get a page of size equal to that which is selected in the driver.

Print from Adobe Photoshop

1. In Photoshop CS5, click File > Print and then select your printer.
2. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, click the Custom button. Enter the width, the length and the name of your custom paper size. Click the Save and OK buttons.
3. You may wish to change the default paper source, paper type and print quality.

4. In the Color tab, the default color management option is **Printer managed colors**, and this is the correct option because you have already selected **Printer Manages Colors** in Photoshop.

---

**Print and scale from Microsoft Office**

This section demonstrates how to print and scale from Microsoft Office 2010.

**Using PowerPoint**

1. Click the **File** tab, then **Print**, and select the name of your printer.
2. Click **Printer Properties > Features > Print document on** to scale the document to a particular size.
3. Click the **Paper/Quality** tab, then **Paper Source** and **Paper Type**.

4. Click **Margins/Layout**, then **Clip contents by margins** to keep the size.

Using Project

1. Click **File > Page Setup > Print**.
2. Select your printer’s name, then Close.

3. Click Page Setup and choose the Paper Size you want.

4. Click Options to go to the printer driver. The default options in the Paper/Quality tab are probably suitable: Paper source: Printer auto select and Paper Type: Any.
5. Click **Features > Print document on** to scale the document to a particular size. Alternatively, you can scale the document in Project.

---

**Using Excel**

1. Click the **Page Layout** tab, then **Size**, and choose the paper size you want.
2. Click the File tab, then Print, and select the name of your printer.

3. Click Printer Properties to go to the printer driver. In the Paper/Quality tab, click Paper source, Paper Type, and Print Quality.
4. Click **Features > Print document on** to scale the document to a particular size. Alternatively, you can scale the document in Excel.
8 Handling ink cartridges and printhead

- About the ink cartridges
- Storage of anonymous usage information
- Check ink cartridge status
- Replace an ink cartridge
- About the printhead
About the ink cartridges

Ink cartridges store the ink and are connected to the printhead, which distributes the ink on the paper. To purchase additional cartridges, see Accessories on page 79.

⚠️ CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see the Glossary on page 128). Avoid touching pins, leads and circuitry.

Storage of anonymous usage information

Each ink cartridge contains a memory chip that assists in the operation of the printer. In addition, this memory chip stores a limited set of anonymous information about the usage of the printer, which can include the following: the date when the cartridge was first installed, the date when the cartridge was last used, the number of pages printed using the cartridge, the page coverage, the frequency of printing, the printing modes used, any printing errors that may have occurred, and the product model. This information helps HP to design future products to meet our customers’ printing needs.

The data collected by the memory chip does not include information that could be used to identify a customer or user of the cartridge or printer.

HP collects a sample of the memory chips from ink cartridges returned to HP’s free return and recycling program (HP Planet Partners: http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/). The sampled memory chips are read and studied in order to improve future HP products.

HP partners who assist in recycling ink cartridges may also have access to the data. Any third party possessing the cartridge may be able to access the anonymous information on the memory chip. If you prefer to not allow access to this information, you can render the chip inoperable. However, after you render the memory chip inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can turn off the memory chip’s ability to collect printer usage information. To do so, access the Embedded Web Server, and click Settings > Anonymous Usage Information Storage. This does not prevent the cartridge from working normally in other respects. However, if you change your mind later, you can restore the factory defaults to resume collecting printer usage information.

Check ink cartridge status

To view the ink levels of your ink cartridges, tap [on the front panel.

For more information, tap More.

You can also get this information from the HP Utility:

- In the HP DesignJet Utility for Windows, go to the Supplies tab to see each cartridge’s status.
- In the HP Utility for Mac OS X, click Supplies Status in the Information group.

For an explanation of the ink cartridge status messages, see ink cartridge status messages on page 106.

Replace an ink cartridge

There are two occasions when you need to replace an ink cartridge:

- The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you can use up the remaining ink in the first cartridge at a more convenient time).
- The ink cartridge is empty or faulty, and you must replace it to continue printing.
**CAUTION:** Do not try to remove an ink cartridge while printing.

**CAUTION:** Remove an ink cartridge only if you are ready to insert another one.

**NOTE:** When a cartridge runs out of ink, the current job is cancelled.

1. Make sure the printer is turned on.
2. If your printer is on a stand, make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.
3. Open the ink cartridge cover on the left-hand side of the printer.
4. Wait until the carriage stops moving.
5. Press the ink cartridge to unlock it.
6. Remove the ink cartridge.
7. Insert the new ink cartridge. Make sure that you insert the ink cartridge into the slot that has the same colored letter as the cartridge you are installing.

8. Close the ink cartridge cover.

About the printhead

The printhead, which is supplied installed in the printer, is connected to the ink cartridges and jets ink onto the paper.

⚠️ **CAUTION:** Observe precautions when handling the printhead, because it is an ESD-sensitive device (see the Glossary on page 128). Avoid touching pins, leads, and circuitry.
9 Maintaining the printer

- Check printer status
- Take care of the printer
- Clean the exterior of the printer
- Print Quality Diagnostic Report
- Clean the printhead
- Align the printhead
- Replace the printhead
- Clean the encoder strip
- Recalibrate the paper advance
- Move or store the printer
- Firmware update
- Software update
- Printer maintenance kits
Check printer status

You can check the current status of the printer in various ways:

- If you start the HP Utility and select your printer, you see a page of information describing the status of the printer and its paper and ink supplies.
- If you access the Embedded Web Server, you see information about the general status of the printer. The Supplies page in the Main tab describes the status of the paper and ink supplies.
- From the front panel, you can get information about the loaded paper and the ink levels.

Take care of the printer

The printer is not designed for any purpose other than printing, and you are not recommended to use it as a table, for two reasons:

- The surface can easily be damaged.
- Anything that falls into the printer can cause more serious damage.

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

**WARNING!** To avoid an electric shock, make sure that the printer is turned off and unplugged before you clean it. Do not let water get inside the printer.

**CAUTION:** Do not use abrasive cleaners on the printer.

Print Quality Diagnostic Report

The Print Quality Diagnostic Report consists of two test patterns designed to highlight printhead reliability problems. It helps you to check the performance of the printhead that is currently installed in your printer, and whether it suffers from clogging or alignment problems.

To print the Print Quality Diagnostic Report:

1. Use the same paper type that you were using when you detected a problem. The test patterns are easiest to evaluate on plain white paper.
2. Check that the selected paper type is the same as the paper type loaded into the printer. See View information about the paper on page 37.
3. At the printer's front panel, tap Image Quality Maintenance > Print diagnostic image.

**NOTE:** The report can also be requested from the Embedded Web Server.

It takes about two minutes to print the Print Quality Diagnostic Report.
Corrective actions

1. If the lines in Test Pattern 1 are not straight and connected, align the printhead (see Align the printhead on page 71).

2. If any of the colored blocks in Test Pattern 2 show white lines, or are faded or completely missing, clean the printhead (see Clean the printhead on page 70). Follow the front-panel prompts and perform all three levels of cleaning if necessary.

3. If the problem remains, clean the printhead again.

4. If the problem remains, replace the ink cartridge (see Replace an ink cartridge on page 65) corresponding to the streaked, faded, or missing color block in Test Pattern 2.

5. If the problem remains, replace the printhead (see Replace the printhead on page 71). If the printhead is still in warranty, contact HP Support (see Contact HP Support on page 122).

Clean the printhead

If your print is streaked or has incorrect or missing colors, the printhead may need to be cleaned.

There are three stages of cleaning. Each stage lasts about two minutes, uses one sheet of paper, and uses an increasing amount of ink. After each stage, review the quality of the printed page. You should initiate the next phase of cleaning only if the print quality is poor.

If print quality still seems poor after you complete all stages of cleaning, try aligning the printhead.

NOTE: Cleaning uses ink, so clean the printhead only when necessary.

NOTE: Failing to turn off the printer correctly can cause print-quality problems.

Clean the printhead from the front panel

1. Make sure there is paper in the input tray or a roll loaded.

2. Go to the front panel and tap then Image Quality Maintenance > Clean printhead.

Clean the printhead from the Embedded Web Server

1. Make sure there is paper in the input tray or a roll loaded.

2. In the Tools tab of the Embedded Web Server, click Print Quality Toolbox > Clean Printhead, and follow the instructions on the screen.
Clean the printhead from the HP Utility

1. Make sure there is paper in the input tray or a roll loaded.

2. **Windows:** In the **Support** tab of the HP Utility, click **Printhead Cleaning**, and follow the instructions on the screen.

3. **Mac OS X:** In the **Information and Print Quality** tab of the HP Utility, click **Clean Printhead**, and follow the instructions on the screen.

Align the printhead

Precise printhead alignment is essential for accurate colors, smooth color transitions, and sharp edges in graphical elements. Your printer has an automatic printhead alignment process which runs whenever a printhead has been accessed or replaced.

You may need to align the printhead after a paper jam or if you are experiencing print-quality problems.

1. Load the paper you wish to use, see [Paper handling on page 29](#). You can use a roll or a cut sheet; plain white paper is recommended.

   **CAUTION:** Do not use transparent or semi-transparent paper to align the printhead.

2. Ensure that the window is closed, as a strong light source near the printer during printhead realignment can affect alignment.

3. From the front panel, tap ![printer icon] then **Image Quality Maintenance > Align printhead**.

   **NOTE:** Printhead alignment can also be started from the Embedded Web Server (**Tools > Print Quality Toolbox > Align Printhead**), or from the HP Utility (**Windows: Support > Printhead Alignment; Mac OS X: Information and Print Quality > Align**).

4. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.

5. The process takes about five minutes. Wait until the front-panel display shows the process complete before using the printer.

If the printer cannot complete the printhead alignment successfully, you may be asked to clean the printhead and try again.

Replace the printhead

**TIP:** When the printhead has been replaced, the printer will automatically perform a printhead alignment on the loaded paper. If you would like to perform the printhead alignment on a different paper (perhaps from the multi-sheet tray), you could change the paper before starting this procedure. Plain white paper is recommended.

1. Make sure the printer is turned on.

2. If your printer is on a stand, make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

3. From the front panel, tap ![printer icon] then **Image quality maintenance > Replace printhead**.
4. Open the ink cartridge cover.

5. Wait until the carriage stops moving.

6. Press each ink cartridge to unlock it.

7. Remove each ink cartridge.
8. Close the ink cartridge cover.

9. Tap Next on the front panel.

10. Open the top cover.

11. Raise the carriage lever.
12. Remove the printhead, keeping it vertical to avoid getting ink on the connections.

13. Insert the new printhead.

14. Lower the carriage lever.

15. Close the top cover.
16. Tap Next on the front panel.

17. Open the ink cartridge cover.

18. Insert the ink cartridges. Make sure that you insert each ink cartridge into the slot that has the same colored letter as the cartridge you are installing.

**IMPORTANT:** If the printhead is new, install new ink cartridges. New ink cartridges are required for successful printhead replacement.

19. Close the ink cartridge cover.

20. Tap Done on the front panel. The front panel recommends a printhead alignment.
Clean the encoder strip

1. Make sure that the printer is not printing and that the carriage is located in the service station on the right-hand side of the printer.

2. Using tap water and a small cloth that will not leave fibers in the printer, dampen the cloth and remove any excess water, so that the cloth is damp but not wet.

3. Open the printer window.

4. Hold the cloth in an inverted U shape around the encoder strip and carefully wipe until no further ink residue appears on the cloth. Be very careful not to scratch the encoder strip with your fingernails or any other object. Make sure that you are holding the cloth correctly.

NOTE: Do not move the carriage away from the service station.

5. Close the printer window.

6. From the front panel, tap then Image quality maintenance > Replace printhead. The carriage moves to the left and stops in the correct position to remove the printhead.

7. Turn off the printer by pressing the power key and then unplugging the power code.

8. Open the printer window and move the carriage further to the left, allowing you to access the service station.

9. Clean the part of the encoder strip inside the service station as described above.

10. Close the printer window.

11. Turn the printer back on.

If you would like further guidance on this procedure, see the Service Manual.

Recalibrate the paper advance

Accurate paper advance is important to image quality because it is part of controlling the proper placement of dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate the rate at which the paper advances. See Troubleshooting print-quality issues on page 94 to determine whether paper advance calibration will solve your issue.

Recalibrating the paper advance procedure

1. From the front panel, tap then Image Quality Maintenance > Paper advance calibration > Calibrate ready paper. The printer automatically recalibrates the paper advance and prints a paper advance calibration image.

2. Wait until the front panel displays the status screen and re-print your print.

NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the paper advance calibration image. The front-panel display shows any errors in the process.
If you are satisfied with your print continue using this calibration for your paper type. If you see improvement in your print, continue with step three. If you are dissatisfied with the recalibration, return to the default calibration, see Return to default calibration on page 77.

Return to default calibration

Returning to the default calibration sets all the corrections made by the paper advance calibration to zero. To return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, tap then Image Quality Maintenance > Paper advance calibration > Reset ready paper calibration.
2. Wait until the front panel displays the operation has completed successfully.

Move or store the printer

If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare the printer, follow the instructions below.

1. Do not remove the ink cartridges or printhead.
2. Make sure that no paper is loaded.
3. Turn off the power using the Power key on the front panel.
4. Unplug the printer's power cord.
5. Disconnect any cables connecting the printer to a network or a computer.

⚠️ **CAUTION:** If you turn the printer upside down, ink could escape into the printer and cause serious damage.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and prepare the printhead. Preparing the printhead normally takes just over a minute. However, if the printer has been off for a six weeks or more, preparing the printhead could take up to 45 minutes.

⚠️ **CAUTION:** If the printer remains off for a long period of time, the printhead may become unusable. In this case, you need to replace the printhead with a new one.

💡 **TIP:** Because preparing and purging the printhead uses both time and ink, you are strongly recommended to leave the printer always on or in sleep mode, whenever possible, to maintain the health of the printhead. In both cases, the printer wakes up from time to time to maintain the printhead. Thus you can avoid going through lengthy preparation processes before using your printer.

Firmware update

There are various ways of downloading and installing firmware updates, as described below; you can choose whichever you find most convenient.

⚠️ **NOTE:** A firmware update package can be large; you may want to consider whether there are any implications for your network or Internet connection.

You can configure the printer to download firmware updates automatically whenever they become available: see Automatic firmware update on page 20.
The following options are available if you choose manual firmware updates:

- Using the front panel, tap the icon then **Web Services > Product update**. Tap **Check now** to check whether new firmware is available. If new firmware is available, you are given the opportunity to download and install it.

- Using the Embedded Web Server, click **Firmware Update**.

- Using the HP DesignJet Utility under Windows, select your printer, the **Support** tab, then **Firmware Update**.

- Using the HP Utility under Mac OS X, click **Update Firmware** in the Support group.

The firmware includes a set of the most commonly used paper presets.

**Software update**

Under Windows or Mac OS X, you are normally offered software updates automatically.


**Printer maintenance kits**

Three maintenance kits are available for your printer, containing components that may need to be replaced after long use. When one of them is needed, a message is displayed on the front panel and by the HP Utility.

When you see the message, you should contact HP Support (see **Contact HP Support on page 122**) and request the maintenance kit. The kits are installed by service engineers only.
10 Accessories

- How to order supplies and accessories
  - Order ink supplies
  - Order paper
  - Order accessories
- Introduction to the accessories
  - Stand
  - Spindle
How to order supplies and accessories

There are two alternative ways to order supplies or accessories for your printer:

- Contact HP Support (see Contact HP Support on page 122).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies

The following ink supplies can be ordered for your printer.

<table>
<thead>
<tr>
<th>Table 10-1 Ink cartridges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cartridge</td>
</tr>
<tr>
<td>HP 711 38 ml Black Ink Cartridge</td>
</tr>
<tr>
<td>HP 711 29 ml Cyan Ink Cartridge</td>
</tr>
<tr>
<td>HP 711 29 ml Magenta Ink Cartridge</td>
</tr>
<tr>
<td>HP 711 29 ml Yellow Ink Cartridge</td>
</tr>
<tr>
<td>HP 711 80 ml Black Ink Cartridge</td>
</tr>
</tbody>
</table>

Order paper

The following paper types are currently provided for use with your printer.

**NOTE:** This list is likely to change over the course of time. For the latest information, see http://www.hp.com/go/LFPrintingMaterials.

**NOTE:** Paper types that HP does not support may nevertheless be compatible with your printer.

Key to availability

- (A) indicates papers available in Asia (excluding Japan)
- (C) indicates papers available in China
- (E) indicates papers available in Europe, the Middle East and Africa
- (J) indicates papers available in Japan
- (L) indicates papers available in Latin America
- (N) indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.
<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP Bond and Coated Paper</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Recycled Bond Paper</td>
<td>80</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in) (A2)</td>
<td>CG892A (E)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>CG889A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>CG890A (EN)</td>
</tr>
<tr>
<td>HP Universal Bond Paper</td>
<td>80</td>
<td>45.7 m (150 ft)</td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q8003A (AJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>Q1396A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1397A</td>
</tr>
<tr>
<td>HP Bright White Inkjet Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in) (A2)</td>
<td>Q1446A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q1445A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C1860A (LJ), C6035A (AEJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in) (A0)</td>
<td>Q1444A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C1861A (LJ), C6036A (AEJ)</td>
</tr>
<tr>
<td>HP Universal Coated Paper</td>
<td>95</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1404A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1405A (AEJN)</td>
</tr>
<tr>
<td>HP Coated Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in) (A2)</td>
<td>Q1443A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>457 mm (18 in)</td>
<td>Q7897A (EJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q1442A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C6019B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in) (A0)</td>
<td>Q1441A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C6020B</td>
</tr>
<tr>
<td>HP Universal Heavyweight Coated Paper</td>
<td>120</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1412A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1413A</td>
</tr>
<tr>
<td>HP Heavyweight Coated Paper</td>
<td>131</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>C6029C (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C6030C</td>
</tr>
<tr>
<td>HP Yellow Colored Paper</td>
<td>92</td>
<td>45.7 m (150 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1760A (EN)</td>
</tr>
<tr>
<td><strong>HP Technical Paper</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Natural Tracing Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q1439A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C3869A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3868A</td>
</tr>
<tr>
<td>HP Translucent Bond Paper</td>
<td>67</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3860A (AJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3859A (LJ)</td>
</tr>
<tr>
<td>HP Vellum Paper</td>
<td>75</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3862A (N)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3861A (LJ)</td>
</tr>
<tr>
<td><strong>HP Film (Technical and Graphic)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Clear Film</td>
<td>174</td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>C3876A (AEJN)</td>
</tr>
</tbody>
</table>
### Table 10-3 Roll paper (continued)

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Matte Film</td>
<td>160</td>
<td>38.1 m (125 ft)</td>
<td>610 mm (24 in)</td>
<td>C3875A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>S1642A (AEJN)</td>
</tr>
<tr>
<td>HP Photographic Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Premium Gloss Photo Paper</td>
<td>240</td>
<td>15.2 m (50 ft)</td>
<td>610 mm (24 in)</td>
<td>CZ984A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q8806A</td>
</tr>
<tr>
<td>HP Premium Satin Photo Paper</td>
<td>240</td>
<td>15.2 m (50 ft)</td>
<td>610 mm (24 in)</td>
<td>CZ987A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q8808A</td>
</tr>
<tr>
<td>HP Universal Gloss Photo Paper</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1426A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1427A (AEJN)</td>
</tr>
<tr>
<td>HP Universal Satin Photo Paper</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1420A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1421A (AEJN)</td>
</tr>
<tr>
<td>HP Universal Instant-dry Gloss Photo Paper</td>
<td>200</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6574A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6575A</td>
</tr>
<tr>
<td>HP Universal Instant-dry Satin Photo Paper</td>
<td>200</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6579A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6580A</td>
</tr>
<tr>
<td><strong>TIP:</strong> The dye inks used by your printer will fade very quickly on instant-dry photo papers. If you plan to display the prints for more than two weeks, you should laminate them to achieve longer life.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Self-Adhesive Material</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Everyday Adhesive Matte Polypropylene</td>
<td>180</td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>CG843A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>CG824A</td>
</tr>
<tr>
<td>HP Banner and Sign Material</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Everyday Matte Polypropylene</td>
<td>120</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>CH022A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>CH023A</td>
</tr>
</tbody>
</table>

### Table 10-4 Sheet paper

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Bond and Coated Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Coated Paper</td>
<td>90</td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>Q1961A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1962A (AEN)</td>
</tr>
<tr>
<td>HP Photographic Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Premium Gloss Photo Paper</td>
<td>240</td>
<td>483 mm (19 in)</td>
<td>330 mm (13 in)</td>
<td>CZ985A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>CZ986A</td>
</tr>
<tr>
<td>HP Premium Satin Photo Paper</td>
<td>240</td>
<td>483 mm (19 in)</td>
<td>330 mm (13 in)</td>
<td>CZ988A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>CZ989A</td>
</tr>
</tbody>
</table>
Order accessories

The following accessories can be ordered for your printer.

<table>
<thead>
<tr>
<th>Name</th>
<th>Product number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet T120 24-in Stand</td>
<td>B3Q35A</td>
</tr>
<tr>
<td>HP DesignJet T120 and T520 24-in Spindle</td>
<td>B3Q36A</td>
</tr>
<tr>
<td>HP DesignJet T520 36-in Spindle</td>
<td>B3Q37A</td>
</tr>
</tbody>
</table>

Introduction to the accessories

Stand

The stand is provided with the T520, except for the T520-24T. It is not provided with the T120 or T520-24T, but may be purchased as an accessory.

Spindle

With extra spindles, you can change rapidly from one paper type to another.
11 Troubleshooting paper issues

- Paper cannot be loaded successfully
- Paper type is not in the driver
- Printer printed on the wrong paper type
- Paper mismatch
- Roll has jammed
- Multi-sheet tray has jammed
- A strip stays on the output tray and generates jams
- Printer displays out of paper when paper is available
- Prints do not fall neatly into the bin
- Sheet stays in the printer when the print has been completed
- Paper is cut when the print has been completed
- Cutter does not cut well
- Roll is loose on the spindle
Paper cannot be loaded successfully

- Ensure that no paper is already loaded.
- Ensure that the paper is far enough inside the printer, you should feel the printer grab the paper.
- Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the front-panel display. The printer automatically attempts to straighten the paper.
- The paper may be crumpled, or warped, or may have irregular edges.

Unsuccessful roll load

- Check that the roll is at least 280 mm (11 in) wide: narrower rolls are not supported.
- Check the leading edge of the paper: if it is not straight or clean, it should be trimmed. Remove the initial 20 mm (1 in) from the roll and try again. This may be necessary even with a new roll of paper.
- Check that the roll ends are tight against the spindle ends.
- Check that the spindle is correctly inserted.
- Check that the output tray is closed. The roll will not load when it is open.
- Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.
- Check that all roll end plugs have been removed.
- Check that the paper is wound tightly on the roll.
- Do not touch the roll or paper at during the alignment process.

If the paper has not been inserted straight, follow the instructions on the front panel.

If you would like to start the load process again, cancel the process on the front panel and rewind the roll from the end of the spindle until the edge is removed from the printer.

NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load

- Check that the sheet is more than 329 mm (12.95 in) wide (A3+). If it is that width or less, load it from the multi-sheet tray.
- Guide the sheet, especially thick papers, when the printer initially feeds the sheet.
- Ensure that the sheet is aligned with the reference line on the roll cover.
- Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-panel display.
- Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects the sheet from the front of the printer.
Unsuccessful load from the multi-sheet tray

- Check that you have not loaded too many sheets into the tray. The maximum number of sheets depends on the paper thickness: around 50 sheets of plain, standard paper.
- Check that the sheets are correctly loaded into the tray.
- Check that the sheets are correctly adjusted and centered in the tray.
- Check that you have extended the input and output trays correctly: the first extension for A4, the second for A3 paper.

If the paper is hanging over the back of the input tray as shown, it may fail to load.

NOTE: Try to avoid leaving sheets of paper loaded in the printer for a significant length of time, because they will deform.

Paper loading error messages

Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

<table>
<thead>
<tr>
<th>Front-panel message</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper loaded with too much skew</td>
<td>During the paper load process the printer detected that the paper had too much skew. Tap OK to unload the roll automatically, then restart the process.</td>
</tr>
<tr>
<td>Paper not detected</td>
<td>During the paper load process the printer did not detect any paper. Ensure the paper is inserted fully and is not transparent.</td>
</tr>
<tr>
<td>Paper too far from lateral edge</td>
<td>Reload the cut sheet, aligning the right edge against the black stop on the spindle.</td>
</tr>
</tbody>
</table>
Paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver, however, you must identify whether your paper is transparent or translucent, photo or bond, coated or technical.

**NOTE:** For glossy paper, it is important to select a glossy paper type, as the printer adjusts its use of ink for glossy paper.

### Transparent or translucent film

If your paper is a transparent film (for example, a transparency), select paper type **Film > Transparent/Clear film.**

If your paper is a translucent paper or film (for example, technical paper), select paper type **Film > Matte film.**

### Photo paper

If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select paper type **Photo Gloss Paper.** For Semi-gloss, Satin, Pearl, or Luster finishes, select paper type **Photo Semi-gloss/Satin Paper.**

To increase gamut on photo paper, select paper type **HP Universal Gloss Photo Paper** or **HP Universal Satin Photo Paper,** depending on the finish.

### Bond and coated or technical paper

Your paper type selection for generic paper depends on the paper’s ink absorption capacity:

- For natural tracing papers, select paper type **Natural Tracing Paper < 65 g/m²** or **Natural Tracing Paper > 65 g/m²,** depending on the weight of the paper.
- For thin papers (< 90 g/m²) or uncoated papers (for example plain paper or bright white paper), select paper type **Bond and Coated Paper > Plain Paper.** You can also select **Recycled Bond Paper.**
- For light coated papers (< 110 g/m²), select paper type **Bond and Coated Paper > HP Coated Paper.**
- For heavyweight coated papers (< 200 g/m²), select paper type **Bond and Coated Paper > Heavyweight Coated Paper.**

### Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink. To use an optimized ink combination, select paper type **Photo Paper > Photo Gloss Paper.**
After printing, the paper has wrinkles or there is too much ink

This happens when too much ink is used. To use less ink, select a thinner category. Matte paper categories from thinnest to thickest are:

- Plain Paper
- Coated Paper
- Heavyweight Coated Paper

For other print-quality problems, see Troubleshooting print-quality issues on page 94.

Printer printed on the wrong paper type

If the printer prints your job before you were able to load your desired paper, you may have Any selected for the Paper Type in the printer driver. When Any is selected the printer will print immediately on whichever paper is loaded. Load your desired paper, see Paper handling on page 29, and select your paper type specifically in the driver.

- In the Windows driver dialog: Click the Paper/Quality tab, then select your paper type from the Paper Type list.
- In the Mac OS X Print dialog: Click the Paper/Quality panel, then select your paper type from the Paper Type list.

**NOTE:** Any is the driver default.

Paper mismatch

If the paper currently loaded in the printer is not suitable for a particular job, the printer stops and waits for you to decide what to do. There are several ways in which the loaded paper may be considered unsuitable:

- The paper type is not as specified for the job.
- The paper source (roll, multi-sheet tray, or manual feed) is not as specified for the job.
- The paper size is smaller than specified for the job.

If you do not specify these things for a particular job, the printer will print on whatever paper is loaded.

If the printer stops for a paper mismatch, you can decide among the following alternatives:

- Load the correct paper and resume printing.
- Print the job on the already-loaded paper. The print may be clipped if the paper is not large enough.
- Cancel the job.

Roll has jammed

When a paper jam occurs, you normally see a message about it in the front-panel display.

1. Open the top cover.
2. Try to move the printhead carriage out of the way.

3. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

⚠️ **CAUTION:** Do not move the paper sideways, as it could damage the printer.
4. Close the top cover.

5. Open the roll cover and rewind the roll. You may feel resistance if the paper is stuck; pull firmly.

6. Reload the roll, or load a new sheet; see Paper handling on page 29.

**NOTE:** If you find that there is still some paper causing an obstruction within the printer, restart the procedure and carefully remove all pieces of paper. You may need to remove the multi-sheet tray (see Multi-sheet tray has jammed on page 90).

### Multi-sheet tray has jammed

If the paper in the multi-sheet tray has jammed, proceed as follows:

1. Remove as much paper as you can from the multi-sheet tray.
2. Push down the multi-sheet tray extensions, which will make the tray easier to handle.
3. Unlock the tray, using the rotary switch behind it.
4. Pull out the tray.

5. Remove all paper from the tray.

6. Remove all paper from the printer.

7. Replace the tray.
8. Lock the tray.

A strip stays on the output tray and generates jams

If a small piece of paper has been cut, such as before printing a new roll, or after the front panel option Form feed and cut has been used, the cut strip may remain in the output tray. Only when the printer is not printing, reach into the tray and remove the strip.

Printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the bin

- Ensure the bin is correctly installed.
- Ensure the bin is open.
- Ensure the bin is not full.
- Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or remove prints manually as they are completed.

Sheet stays in the printer when the print has been completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time on page 37. If the paper is only partially ejected after the drying time, gently pull the sheet out of the printer. If the automatic cutter is disabled, use the Form feed and cut option in the front panel, see Form feed with or without cutting on page 38.
Paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed, see Change the drying time on page 37. You can disable the cutter, see Turn the automatic cutter on and off on page 37.

Cutter does not cut well

By default, the printer is set to cut the paper automatically after the drying time has been completed.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any obstacles, and check that there are no pieces of paper in the cutter groove.

Roll is loose on the spindle

The roll may need to be replaced or reloaded.
12  Troubleshooting print-quality issues

- General printing advice
- Horizontal lines across the image (banding)
- Lines are too thick, too thin or missing
- Lines appear stepped or jagged
- Lines print double or in the wrong colors
- Lines are discontinuous
- Lines are blurred
- Line lengths are inaccurate
- Whole image is blurry or grainy
- Paper is not flat
- Print is scuffed or scratched
- Ink marks on the paper
- Black ink comes off when you touch the print
- Edges of objects are stepped or not sharp
- Edges of objects are darker than expected
- Vertical lines of different colors
- White spots on the print
- Colors are inaccurate
- Colors are fading
- Image is incomplete (clipped at the bottom)
- Image is clipped
- Some objects are missing from the printed image
- A PDF file is clipped or objects are missing
- If you still have a problem
General printing advice

When you have any print-quality problem:

- To achieve the best performance from your printer, use only genuine manufacturer’s supplies and accessories, whose reliability and performance have been thoroughly tested to give trouble-free performance and best-quality prints. For details of recommended papers, see Order paper on page 80.

- Make sure that the paper type selected in the front panel is the same as the paper type loaded into the printer (see View information about the paper on page 37). Also make sure that the paper type selected in your software is the same as the paper type loaded into the printer.

⚠️ CAUTION: If you have the wrong paper type selected, you could experience poor print quality and incorrect colors, and perhaps even damage to the printhead.

- Check that you are using the most appropriate print-quality settings for your purposes (see Printing on page 39). You are likely to see lower print quality if you have moved the print-quality slider to the ‘Speed’ end of the scale, or set the custom quality level to Fast.

- Check that your environmental conditions (temperature, humidity) are in the recommended range. See Environmental specifications on page 127.

Horizontal lines across the image (banding)

If your printed image suffers from added horizontal lines as shown (the color may vary):

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 37.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 39). In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set the Print Quality slider to Speed, try setting it to Quality.


4. If the printhead is working correctly, perform paper advance calibration: see Recalibrate the paper advance on page 76.

If the problem persists despite all the above actions, contact your customer service representative for further support.
Lines are too thick, too thin or missing

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 37.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 39). Select the custom print-quality options in the driver dialog, and try turning on the Maximum detail option (if available).

3. If the resolution of your image is greater than the printing resolution, you may notice a loss of line quality. You can find the Max. Application Resolution option in the driver dialog’s Advanced tab, under Document Options > Printer Features.

4. If lines are too thin or missing, print the Print Quality Diagnostic Report. See Print Quality Diagnostic Report on page 69.

5. If the problem remains, perform paper advance calibration: see Recalibrate the paper advance on page 76.

If the problem persists despite all the above actions, contact your customer service representative for further support.

Lines appear stepped or jagged

If lines in your image appear stepped or jagged when printed:

1. The problem may be inherent in the image. Try to improve the image with the application you are using to edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 39.

3. Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option (if available).
Lines print double or in the wrong colors

This problem can have various visible symptoms:

- Colored lines are printed double, in different colors.

- The borders of colored blocks are wrongly colored.

To correct this kind of problem, print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See Print Quality Diagnostic Report on page 69.

Lines are discontinuous

If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings. See Printing on page 39.
2. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See Print Quality Diagnostic Report on page 69.
Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing. See Environmental specifications on page 127.

2. Check that the paper type selected in the front panel is the same as the paper type you are using. See View information about the paper on page 37.

3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper.

4. Select a lower print quality (such as Speed); the printer will then use less ink.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper.

6. If you are using glossy paper, try changing to a different type of glossy paper.

7. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See Print Quality Diagnostic Report on page 69.

Line lengths are inaccurate

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your purposes, you can try to improve line length accuracy in the following ways:

1. Print on HP Matte Film, for which your printer’s line length accuracy is specified. See Functional specifications on page 124.

   Polyester film is about ten times more dimensionally stable than paper. However, using film that is thinner or thicker than HP Matte Film will reduce line length accuracy.

2. Set the Print Quality slider to Quality.

3. Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).

4. Load the roll of film and let it rest for five minutes before printing.

5. If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance on page 76.
Whole image is blurry or grainy

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 37.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 39). In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set the Print Quality slider to Speed, try setting it to Quality.

4. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See Print Quality Diagnostic Report on page 69.

5. If the problem remains, perform paper advance calibration: see Recalibrate the paper advance on page 76.

If the problem persists despite all the above actions, contact your customer service representative for further support.

Paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes saturated with ink.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 37.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.

3. Select a lower print quality (such as Speed); the printer will then use less ink.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper.
Print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This is particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the bin or to anything else that it contacts soon after printing, depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:

- Handle prints carefully.
- Avoid stacking prints on top of each other.
- Catch your prints as they are cut from the roll and do not let them fall into the bin. Alternatively, leave a sheet of paper in the bin so that freshly printed sheets do not make direct contact with the bin.
- Increase the drying time. At the front panel, tap then Printer Preferences > Print Retrieval > Select drying time > Extended.

Ink marks on the paper

This problem can occur for several different reasons.

Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the printhead moves over the paper, the printhead may come into contact with the paper and smear the printed image. This problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Tap and also cancel the job from your computer application. Soaked paper can damage the printhead.

If you notice poor print quality after this has happened, clean the printhead. See Clean the printhead on page 70.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 37.

2. Use a recommended paper type (see Order paper on page 80) and the correct print settings.

3. If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect performance.

4. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.
5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper.

6. Try to increase the margins by relocating the image to the center of the page using your software application.

**Ink marks on the back of the paper**

Clean the platen with a soft cloth. Clean each rib separately.

**Black ink comes off when you touch the print**

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select Photo Glossy Paper as the paper type (in the Photo Paper category).

**Edges of objects are stepped or not sharp**

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the print-quality slider to **Quality** in the driver dialog, select the custom print-quality options, and try setting the quality level to **Speed**. See **Printing on page 39**.

**Edges of objects are darker than expected**

If edges of objects seem darker than expected, and you have already set the print-quality slider to **Quality** in the driver dialog, select the custom print-quality options, and try setting the quality level to **Speed**. See **Printing on page 39**.
Vertical lines of different colors

If your print has vertical bands of different colors along it:

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated Paper. See Order paper on page 80.
2. Try using higher print-quality settings (see Printing on page 39). For instance, if you have set the Print Quality slider to Speed, try setting it to Quality.

White spots on the print

You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating material. To avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.
2. Always keep the cover of your printer closed.
3. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:

1. Check that the paper type you have loaded corresponds to the paper type selected.
2. Check that you are printing on the correct side of the paper.
3. Check that you are using appropriate print-quality settings. For the most accurate colors, select Normal or Best quality.

Colors are fading

If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more than two weeks, you should laminate them to achieve longer life.

Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life of prints (depending on the type of lamination) with all paper types. For more information, consult your laminate provider.
Did you tap \(\mathbb{E}\) before all the data were received by the printer? If so, you have ended the data transmission and will have to print the page again.

The I/O timeout setting may be too short. This setting determines how long the printer waits for the computer to send more data, before deciding that the job is finished. From the front panel, increase the I/O timeout setting to a longer period and then send the print again. Tap \(\mathbb{E}\) then Connectivity > Advanced setup > Select I/O timeout.

There may be a communications problem between your computer and the printer. Check your USB or network cable, or your Wi-Fi connection.

Check to make sure that your software settings are correct for your current page size (for example, long-axis prints).

If you are using network software, make sure it has not timed out.

Image is clipped

Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the printable area as understood by your software.

- Check the actual printable area for the paper size you have loaded.
  \[
  \text{printable area} = \text{paper size} - \text{margins}
  \]
- Check what your software understands to be the printable area (which it may call "printing area" or "imageable area"). For example, some software applications assume standard printable areas that are larger than those used in this printer.
- If you have defined a custom page size with very narrow margins, the printer may impose its own minimal margins, clipping your image slightly. You may want to consider using a larger paper size.
- If your image contains its own margins, you may be able to print it successfully by using the Clip Contents by Margins option (see Select margins options on page 43).
- If you are trying to print a very long image on a roll, check that your software is capable of printing an image of that size.
- You may have asked to rotate the page from portrait to landscape on a paper size that is not wide enough.
- If necessary, reduce the size of the image or document in your software application, so it fits between the margins.

Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific workflows there may be issues that can lead to some objects missing from the output. Here are some suggestions to help you to avoid this problem:

- Tell the HP-GL/2 driver to send the image as a bitmap.
- Select a smaller page size and scale to the desired final page size in the driver or in the front panel.
- Save the file in another format, such as TIFF or EPS, and open it with another application.
- Use a RIP to print the file.
Reduce the resolution of bitmap images in your application software.

Select a lower print quality in order to reduce the resolution of the printed image.

**NOTE:** If you are working under Mac OS X, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality or the time necessary to generate the print job. Therefore, they should be cancelled if they do not help to solve the problem.

**A PDF file is clipped or objects are missing**

In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some objects when printing with the HP-GL/2 and HP RTL driver at high resolution. In order to avoid such problems, upgrade your Adobe Acrobat or Adobe Reader software to the latest version. From version 7 onwards, these problems should be solved.

**If you still have a problem**

If you still experience print-quality problems after applying the advice in this chapter, here are some further things that you can do:

- Try using a higher print-quality option. See *Printing on page 39*.
- Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be downloaded from [http://www.hp.com/go/T120/software](http://www.hp.com/go/T120/software) or [http://www.hp.com/go/T520/software](http://www.hp.com/go/T520/software).
- Check that your printer's firmware is up to date. See *Firmware update on page 77*.
- Check that you have the right settings in your software application.
13 Troubleshooting ink cartridge and printhead issues

- Cannot insert an ink cartridge
- Ink cartridge status messages
- Cannot insert the printhead
Cannot insert an ink cartridge

1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the slot.
3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side up and readable.

⚠️ CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:

- **OK**: The cartridge is working normally, with no known problems.
- **Missing or Damaged**: There is no cartridge present, or it is not correctly connected to the printer (shown with an X on the status screen).
- **Low**: The ink level is low.
- **Out of ink**: The cartridge is empty.
- **Not genuine HP**: The cartridge is not a genuine HP cartridge.
- **Wrong slot**: The cartridge has been inserted into the wrong slot.
- **Incompatible**: The cartridge is incompatible with this printer.

Cannot insert the printhead

1. Check that you have the correct type of printhead (model number).
2. Check that you have removed the orange protective cap from the printhead.
3. Check that the printhead is correctly oriented.
4. Check that you have correctly latched the printhead, see Replace the printhead on page 71.
14 Troubleshooting data communication issues

- Communication failures between computer and printer
- Wired network issues
  - Network port created does not match printer IP address (Windows)
- Wireless network issues
  - Advanced wireless network troubleshooting
  - Add hardware addresses to a wireless access point (WAP)
- Mobile Printing issues
- Network configuration page
Communication failures between computer and printer

Some symptoms are:

- The front-panel display does not show the *Printing* message when you have sent an image to the printer.
- Your computer displays an error message when you are trying to print.
- Your computer or printer hangs (stays idle), while communication is taking place.
- Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

- Ensure that you have selected the correct printer in your application, see *Printing on page 39*.
- Ensure that the printer works correctly when printing from other applications.
- Remember that very large prints may take some time to receive, process and print.
- If the printer is connected to a network, check the printer connectivity status: the printer should have an IP address and it should match the IP address specified in the printing computer. If the addresses do not match, then configure it correctly; if the issue persists, check your network configuration or try connecting to the printer by USB cable.
- Try another interface cable.
- If the printer is connected by USB cable, try disconnecting and reconnecting the USB cable. Also try using a different USB port on the computer.
- If the printer is connected to a wireless network, you can request a diagnostic report from the front panel: tap \[\text{ \ }\] then **Settings > Print Wireless Network Test**. Alternatively, try moving the printer closer to the wireless router, or try connecting the printer by wired network or USB cable.

When a network device automatically configures itself by receiving an IP address from the DHCP service, this IP address may change from the last time the device is powered off to the next time it is powered on, which may lead to the device being shown as "offline" when driver port settings are configured with the original IP address. There are at least three possible ways to avoid this:

- Increase the lease time of your DHCP server device.
- Set a fixed IP address for your printer that will not be changed by DHCP.
- Configure the printer and driver to refer to the hostname instead of the numeric IP address.

To set a fixed IP address for the printer:

1. Go to the front panel and tap \[\text{ \ }\] or \[\text{ \ }\].
2. At the bottom of the screen, tap **Settings > Advanced setup > IP settings > OK > Manual**, and enter the IP address, the subnet mask, and the gateway (those settings should be provided by your network administrator).

To use the hostname instead of the numeric IP address:

1. Go to the front panel and tap \[\text{ \ }\] or \[\text{ \ }\].
2. Take a note of the IP address and the hostname (HPXXXXXX format).
3. If your computer is running Windows, go to **Control Panel > Printers**, right-click the printer and click **Properties > Ports > Configure Port**, and in the Printer name or IP address field enter the hostname.
Wired network issues

If you are unable to install the HP software provided with the printer, check that:

● All cable connections to the computer and the printer are secure.
● The network is operational and the network hub is turned on.
● All applications, including virus protection programs, spyware protection programs, and firewalls, are closed or disabled for computers running Windows.
● The printer is installed on the same subnet as the computers that use the printer.

If the installation program cannot discover the printer, print the network configuration page, and enter the IP address manually in the installation program. For more information, see Network configuration page on page 112.

Though it is not recommended that you assign a static IP address to the printer, you might resolve some installation problems (such as a conflict with a personal firewall) by doing so. See Communication failures between computer and printer on page 108.

Network port created does not match printer IP address (Windows)

If you are using a computer running Windows, make sure that the network ports created in the printer driver match the printer's IP address.

1. Print the printer’s network configuration page.

2. Click Start, point to Settings, then click Printers or Printers and Faxes.
   – or –

   Click Start, click Control Panel, then double-click Printers.

3. Right-click the printer icon, click Properties, and then click the Ports tab.

4. Select the TCP/IP port for the printer, and then click Configure Port.

5. Compare the IP address listed in the dialog box and make sure it matches the IP address listed on the network configuration page. If the IP addresses are different, change the IP address in the dialog box to match the address on the network configuration page.

6. Click OK twice to save the settings and close the dialog boxes.

Wireless network issues

1. Make sure the wireless (802.11) light at the top left of the front panel is turned on.

   If the blue light is not lit, the wireless capabilities may not have been turned on. To turn on wireless, tap , then Settings > Wireless > On.

2. Make sure that an Ethernet cable has not been connected to the printer. Connecting an Ethernet cable turns off the printer’s wireless capabilities.
3. **Restart components of the wireless network.**

   Turn off the router and the printer, and then turn them back on in this order: router first and then the printer. If you still are unable to connect, turn off the router, printer, and your computer. Sometimes, turning off the power and then turning it back on can solve a network communication issue.

4. **Run the Wireless Network Test.**

   For wireless networking issues, run the Wireless Network Test. To print a Wireless Network Test page, tap then **Settings > Print Wireless Network Test.** If a problem is detected, the printed test report includes recommendations that could help to solve the problem.

### Advanced wireless network troubleshooting

If you have tried the above suggestions and are still unable to connect to your printer to the wireless network, try the following:

1. Make sure that your computer's wireless networking has been turned on. For more information, see the documentation that came with your computer.

2. If you are not using a unique network name (SSID), then it is possible that your computer could be connected to a nearby network that is not yours. The following steps can help you to determine whether your computer is connected to your network.

   **Windows**
   
   a. Click **Start**, click **Control Panel**, point to **Network Connections**, then click **View Network Status and Tasks**.

      – or –

   Click **Start**, then **Settings**, click **Control Panel**, double-click **Network Connections**, click the **View** menu, then select **Details**.

      Leave the network dialog box open while you continue to the next step.

   b. Disconnect the power cord from the wireless router. The connection status of your computer should change to **Not Connected**.

   c. Reconnect the power cord to the wireless router. The connection status should change to **Connected**.

   **Mac OS X**

   ▲ Click the AirPort icon in the menu bar at the top of the screen. From the menu that appears, you can determine if the AirPort is turned on and which wireless network your computer is connected to.

   **TIP:** For more detailed information about your AirPort connection, click **System Preferences** in the Dock, then click **Network**. If the wireless connection is working correctly, a green dot appears next to AirPort in the list of connections. For more information, click the **Help** button in the window.

If you are unable to get your computer connected to your network, contact the person who set up your network or the router manufacturer as there may be a hardware issue with your router or computer.

If you are able to access the Internet and are using a computer running Windows, you can also access HP Network Assistant at [http://www.hp.com/sbso/wireless/tools-setup.html?jumpid=reg_R1002_USEN](http://www.hp.com/sbso/wireless/tools-setup.html?jumpid=reg_R1002_USEN) for help in setting up a network (this website is available in English only).

3. Print the printer's Wireless Configuration page (see **Network configuration page on page 112**). After the page has been printed, check the Network Status and URL. The Network Status is **Ready** if the printer is actively connected to a network, or **Offline** if it is not (in the latter case, run the Wireless Network Test). The URL is the network address assigned to the printer by your router; you need it to connect to the printer’s Embedded Web Server.
4. If you have established that the computer and the printer both have active connections to a network, you can check whether they are on the same network by trying to access the printer’s Embedded Web Server (see Access the Embedded Web Server on page 24).

5. If you cannot access the Embedded Web Server and are sure that both the computer and printer have active connections to the same network, the firewall security software could be blocking communication. Temporarily turn off any firewall security software running on your computer, and try to access the Embedded Web Server again. If you can access it, try using the printer for printing.

   If you are able to access the Embedded Web Server and use your printer with the firewall turned off, you need to reconfigure your firewall settings to allow the computer and printer to communicate with each other over the network.

   If you are able to access the Embedded Web Server, but are still unable to use the printer even with the firewall turned off, try enabling the firewall software to recognize the printer.

6. If you have the HP software installed, you can check the printer’s status from your computer to check whether the printer is paused or offline, preventing you from using it.

   **Windows**

   a. Click Start, point to Settings, then click Printers or Printers and Faxes.

   – or –

   Click Start, click Control Panel, then double-click Printers.

   b. If the printers on your computer are not being displayed in Details view, click the View menu, then click Details.

   c. Do one of the following, depending on the printer status:

   - If the printer is Offline, right-click the printer, and click Use Printer Online.

   - If the printer is Paused, right-click the printer, and click Resume Printing.

   d. Try using the printer over the network.

   **Mac OS X**

   a. Click System Preferences in the Dock, then click Print & Fax.

   b. Select the printer, then click Print Queue.

   c. If Jobs Stopped appears in the resulting window, click Start Jobs.

7. If you install the HP software a second time, the installer may create a second version of the printer driver in your Printers or Printers and Faxes folder (Windows only). If you have difficulties printing or connecting to the printer, make sure the correct version of the printer driver is set as the default.

   a. Click Start, point to Settings, then click Printers or Printers and Faxes.

   – or –

   Click Start, click Control Panel, then double-click Printers.

   b. Right-click the printer icon, and then click Properties, Document Defaults, or Printing Preferences.
c. On the Ports tab, look for a port in the list with a checkmark. The version of the printer driver that is connected wirelessly has **Standard TCP/IP Port** as the Port description, next to the checkmark.

d. Right-click the printer icon for the version of the printer driver that is connected wirelessly, and click **Set as Default Printer**.

8. Try restarting the HP Network Device Support service (Windows only).
   a. Delete any print jobs currently in the print queue.
   b. On the desktop, right-click **My Computer** or **Computer**, then click **Manage**.
   c. Double-click **Services and Applications**, then click **Services**.
   d. Scroll down the list of services, right-click **HP Network Devices Support**, then click **Restart**.
   e. After the service restarts, try using the printer over the network again.

If you are able to use the printer over the network, your network setup was successful.

If you still cannot use the printer over the network, or if you have periodic problems in doing so, your firewall may be interfering, or there may be a problem with your network configuration or router. Contact the person who set up your network or the router manufacturer for help.

**Add hardware addresses to a wireless access point (WAP)**

MAC filtering is a security feature in which a WAP is configured with a list of MAC addresses (also called “hardware addresses”) of devices that are allowed to gain access to the network through the WAP. If the WAP does not have the hardware address of a device attempting to access the network, the WAP denies the device access to the network. If the WAP filters MAC addresses, then the printer’s MAC address must be added to the WAP’s list of accepted MAC addresses.

1. Print the network configuration page. For more information, see Network configuration page on page 112.

2. Open the WAP’s configuration utility, and add the printer’s hardware address to the list of accepted MAC addresses.

**Mobile Printing issues**

For any issues with HP ePrint, visit HP Connected: [http://www.hpconnected.com](http://www.hpconnected.com) (availability varies by product, country, and region).

**Network configuration page**

If the printer is connected to a network, you can print a network configuration page to view the network settings for the printer. You can use the network configuration page to help troubleshoot network connectivity problems. If you need to call HP, it is often useful to print this page before calling.

To print the network configuration page from the front panel: tap then **Internal Prints > User Information Prints > Network Configuration Page**.
1. **General Information:** Shows information about the current status and active connection type of the network, and other information, such as the URL of the Embedded Web Server.

2. **802.3 Wired:** Shows information about the active wired network connection, such as the IP address, subnet mask, default gateway, and hardware address of the printer.

3. **802.11 Wireless:** Shows information about your wireless network connection, such as the hostname, IP address, subnet mask, default gateway, and server.

4. **Miscellaneous:** Shows information about more advanced network settings.
   - Port 9100: The printer supports raw IP printing through TCP Port 9100. This HP-proprietary TCP/IP port on the printer is the default port for printing. It is accessed by HP software (for example, the HP Standard Port).
   - LPD: Line Printer Daemon (LPD) refers to the protocol and programs associated with line-printer spooling services that may be installed on various TCP/IP systems.

   **NOTE:** The LPD functionality can be used with any host implementation of LPD that complies with the RFC 1179 document. The process for configuring printer spoolers, however, might differ. See your system documentation for information about configuring these systems.

   - Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name System) are typically used on small networks for IP address and name resolution (through UDP port 5353), where a conventional DNS server is not used.

   - SLP: Service Location Protocol (SLP) is an Internet standard network protocol that provides a framework to allow networking applications to discover the existence, location, and configuration of networked services in enterprise networks. This protocol simplifies discovery and use of network resources such as printers, Web servers, fax machines, video cameras, file systems, backup devices (tape drives), databases, directories, mail servers, and calendars.

   - Microsoft Web Services: Enable or disable the Microsoft Web Services Dynamic Discovery (WS Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services supported on the printer. Disable unused print services to prevent access through those services.

   **NOTE:** For more information about WS Discovery and WSD Print, visit [http://www.microsoft.com/](http://www.microsoft.com/).

   - SNMP: SNMP (Simple Network Management Protocol) is used by network management applications for device management. The printer supports SNMPv1 protocol on IP networks.

   - WINS: If you have a Dynamic Host Configuration Protocol (DHCP) server on your network, the printer automatically obtains its IP address from that server and registers its name with any RFC 1001 and 1002-compliant dynamic name services as long as a WINS server IP address has been specified.

5. **Connected PC(s):** Lists the computers connected to this printer, as well as the last time these computers accessed the printer.
15 Troubleshooting general printer issues

- Printer does not start
- Printer does not print
- Printer seems slow
- Front panel is frozen
- Cannot access the Embedded Web Server
- Alerts
Printer does not start

If the printer does not start (the front panel is blank), hold down the Power key for a few seconds and check whether the Power LED turns orange while the key is held down.

- If you see no orange light, no power is reaching the printer; check that the power cord is correctly plugged in. If the problem persists, call HP Support (see HP Customer Care on page 119) and explain that you have a problem with the power supply.
- If you see the orange light, wait for the printer to make a beeping sound.
  - Three beeps or no beeps means that the front panel is broken; call HP Support and explain.
  - One long beep means an electronic problem; call HP Support and explain.

Printer does not print

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why a file you have sent from your computer may not start printing when expected:

- You may have an electrical power problem. If there is no activity at all from the printer, and the front panel does not respond, check that the power cord is connected correctly and that there is power available at the socket.
- You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this case, turn off the printer using the Power key on the front panel and unplug the power cord, wait until the electromagnetic environment has returned to normal, then turn it on again. If you still experience problems, contact your customer service representative.
- You may not have installed in your computer the correct driver for your printer, see the Assembly instructions.
- If you are printing on a sheet, you must specify Printer Autoselect or Single-Sheet or Multi-Sheet Tray as the paper source in your printer driver.

Printer seems slow

Here are some possible explanations:

- Did you set the print-quality to Best or Max Detail? Best-quality and maximum detail prints take longer.
- Did you specify the correct paper type when loading the paper? Some paper types require more time for printing; for example, photo and coated papers require more drying time between passes. To find out the printer’s current paper type setting, see View information about the paper on page 37.
- If your printer is connected by network, check that all components used in the network (network interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of traffic from other devices on the network?
- If your printer is connected by USB, make sure that the USB host controller and the USB hubs used (if any) are USB 2.0; and check that the USB cables are USB 2.0 certified.
- If your printer is using a wireless network connection, try using a wired network or USB connection.
- Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.
Front panel is frozen

If the front panel displays a fixed image and you are unable to use it, call HP Support (see HP Customer Care on page 119).

Cannot access the Embedded Web Server

If you have not done so already, please read Access the Embedded Web Server on page 24.

NOTE: If you connect directly to your printer with a USB cable, you cannot access the Embedded Web Server.

If you are using a proxy server, try bypassing the server and accessing the Web server directly:

- In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more precise control, click the Advanced button and add the printer’s IP address to the list of exceptions, for which the proxy server is not used.

- In Safari for Mac OS X, go to Safari > Preferences > Advanced and click the Proxies: Change Settings button. Add the printer’s IP address or its domain name to the list of exceptions, for which the proxy server is not used.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Alerts

Your printer can communicate two types of alerts:

- **Errors**: Mainly alerting you to the fact that the printer is unable to work normally. However, in the printer driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is able to print.

- **Warnings**: Alert you when the printer needs attention either for an adjustment, such as a calibration or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer’s system:

- **Front-panel display**: The front panel shows only the most relevant alert at a time. In the case of a warning, it disappears after a timeout. There are permanent alerts, such as “ink cartridge low on ink”, that reappear when the printer becomes idle and there is not another more severe alert.

- **Embedded Web Server**: The upper-right corner of the Embedded Web Server window shows the printer status. If there is an alert in the printer, the status shows the alert text.

- **Driver**: The driver shows alerts. The driver warns about job configuration settings that may produce a problem in the final output. If the printer is not ready to print, it displays a warning.

- **HP Utility**: If the HP Utility is installed, alerts can be automatically displayed under Windows and Mac OS X: a new panel opens on your screen with a list of alerts for each printer. This display of alerts can be activated under Mac OS X through the HP Printer Monitor, on under Windows by the Alerts Settings in the HP DesignJet Utility. You can also see the list of active alerts in the Overview tab of the HP DesignJet Utility for Windows.

By default, error alerts (critical alerts) are always displayed and warning alerts (non-critical alerts) as displayed only when you are printing. If alerts are enabled and there is a problem that prevents a job from completing, you see a pop-up window, which explains the reason for the problem. Follow the instructions to achieve your required result.

NOTE: There are environments that do not support bidirectional communication. In those cases, alerts do not reach the job owner.
Occasionally you may see one of the following messages appear on the front-panel display. If so, follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, or if the recommended action does not seem to solve the problem, contact HP Support. See Contact HP Support on page 122.

Table 16-1  Text messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Color] cartridge has expired</td>
<td>Replace the cartridge. See Replace an ink cartridge on page 65.</td>
</tr>
<tr>
<td>[Color] cartridge is low on ink</td>
<td>Ensure that you have a new cartridge of the same color ready.</td>
</tr>
<tr>
<td>[Color] cartridge is very low on ink</td>
<td>Ensure that you have a new cartridge of the same color ready.</td>
</tr>
<tr>
<td>Depleted cartridges must be replaced to resume printing</td>
<td>Replace the cartridges as needed. See Replace an ink cartridge on page 65.</td>
</tr>
<tr>
<td>Ink system failure</td>
<td>Contact HP Support. See Contact HP Support on page 122.</td>
</tr>
<tr>
<td>Maintenance 1 advised</td>
<td>Contact HP Support. See Contact HP Support on page 122.</td>
</tr>
<tr>
<td>Maintenance 2 advised</td>
<td>Contact HP Support. See Contact HP Support on page 122.</td>
</tr>
<tr>
<td>Maintenance 3 advised</td>
<td>Contact HP Support. See Contact HP Support on page 122.</td>
</tr>
<tr>
<td>One or more cartridges appear to be missing or damaged</td>
<td>Insert cartridges of the correct color as needed. See Replace an ink cartridge on page 65.</td>
</tr>
<tr>
<td>Paper jam</td>
<td>See Roll has jammed on page 88 or Multi-sheet tray has jammed on page 90.</td>
</tr>
<tr>
<td>Paper width is smaller than the minimum size supported by the selected paper source. Load cancelled.</td>
<td>Remove the paper and load paper of the correct size.</td>
</tr>
<tr>
<td>Loaded paper is too wide. Manual unload required.</td>
<td>Remove the paper manually and load paper of the correct size.</td>
</tr>
<tr>
<td>Paper too far from lateral load line. Please try again.</td>
<td>Remove and reload the paper.</td>
</tr>
<tr>
<td>Please manually unload roll paper and try again.</td>
<td>Rewind the roll manually.</td>
</tr>
<tr>
<td>Single sheet is loaded with too much skew. Press Eject to unload paper.</td>
<td>Remove and reload the paper.</td>
</tr>
<tr>
<td>The current job has been cancelled because the roll is out of paper. Load the roll and send the job again.</td>
<td>Load a new roll.</td>
</tr>
<tr>
<td>You are printing a multipage job. Load another sheet to continue printing or cancel the job.</td>
<td>Load another single sheet.</td>
</tr>
<tr>
<td>Multi-sheet tray is out of paper. Load paper in multi-sheet tray and press OK to continue printing or cancel the job.</td>
<td>Load paper into the multi-sheet tray.</td>
</tr>
<tr>
<td>End of roll has been reached. It is not possible to load the roll.</td>
<td>Load a new roll.</td>
</tr>
</tbody>
</table>
### Table 16-1  Text messages (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missing or failed printhead.</td>
<td>Remove and reinsert the same printhead, or try cleaning the electrical connections. If necessary, insert a new printhead. See Replace the printhead on page 71.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The error message does not permit returning to the home screen to start the printhead replacement. Instead, press Show more.</td>
</tr>
<tr>
<td>Refilled or depleted cartridge detected</td>
<td>Check the cartridge.</td>
</tr>
<tr>
<td>Used cartridges might not have enough ink to complete startup. Open ink door to replace the cartridges.</td>
<td>A new printhead has been inserted without a new set of ink cartridges. Replace the cartridges not marked as new. See Replace an ink cartridge on page 65.</td>
</tr>
<tr>
<td>Wrong file format.</td>
<td>The file format is incorrect or not supported. The printer cannot process the job, which will be discarded.</td>
</tr>
<tr>
<td>Out of memory.</td>
<td>The printer cannot complete the job. Resend the job, selecting Send job as bitmap in the driver: go to the Advanced tab, then Document options &gt; Printer features.</td>
</tr>
</tbody>
</table>

### Table 16-2  Numerical error codes

<table>
<thead>
<tr>
<th>Error code</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>01.1:10</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>02:10</td>
<td>There may be a paper or carriage jam. Check and clear the paper path if necessary.</td>
</tr>
<tr>
<td>03:0:10</td>
<td>The battery of the real-time clock has expired; contact HP Support. See Contact HP Support on page 122.</td>
</tr>
<tr>
<td>08:10, 11:10, 17:10</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>21:10</td>
<td>There may be a paper or carriage jam. Check and clear the paper path if necessary.</td>
</tr>
<tr>
<td>21.1:10</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>41:10, 41.1:10, 42:10, 42.1:10, 45:10</td>
<td>There may be a paper or carriage jam. Check and clear the paper path if necessary.</td>
</tr>
<tr>
<td>51.1:10, 55:10</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>79:04</td>
<td>Restart the printer. If the problem persists, update the firmware. See Firmware update on page 77.</td>
</tr>
<tr>
<td>85:1:10, 85.2:10</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>87:10</td>
<td>There may be a paper or carriage jam. Check and clear the paper path if necessary. Also clean the carriage encoder strip; see Clean the encoder strip on page 75.</td>
</tr>
</tbody>
</table>
17 HP Customer Care

- Introduction
- HP Professional Services
- HP Proactive Support
- Customer Self Repair
- Contact HP Support
Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, providing comprehensive, proven support expertise and new technologies to give you unique end-to-end support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, phone and Web support, software updates and self-maintenance services. To find out more about HP Customer Care, please visit us at http://www.hp.com/go/graphic-arts or call us on the telephone (see Contact HP Support on page 122).

TIP: By taking just a few minutes to register, you can improve your experience with HP and enjoy more efficient support. Click http://register.hp.com/ to start. Also click http://www.hp.com/go/alerts to get connected with DesignJet updates, including product fixes and enhancements.

HP Professional Services

HP Support Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your HP DesignJet printers and solutions.

Join the HP community at the HP Support Center, your large-format printing community, for 24×7 access to:

- Multimedia tutorials
- Step-by-step how-to guides
- Downloads: the latest printer firmware, drivers, software, etc.
- Technical support: online troubleshooting, customer care contacts and more
- Workflows and detailed advice for completing various printing tasks from particular software applications
- Forums for direct contact with the experts, both HP and your colleagues
- Warranty tracking online, for your peace of mind
- Latest product information: printers, supplies, accessories, software, etc.
- Supplies Center for all you need to know about ink and paper

The HP Support Center can be found at http://www.hp.com/go/T120/support or http://www.hp.com/go/T520/support.

By customizing your registration for the products you have purchased and your type of business, and by setting your communication preferences, you decide the information you need.

HP Start-Up Kit

The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer's software and documentation.

HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard period.

They include remote support. On-site service is also provided if necessary, with two alternative response-time options:

- Next business day
- Same business day, within four hours (may not be available in all countries)
For more information on HP Care Packs, visit [http://www.hp.com/go/printservices](http://www.hp.com/go/printservices).

**HP Installation**

The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, visit [http://www.hp.com/go/printservices](http://www.hp.com/go/printservices).

**HP Proactive Support**

HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and resolving printer issues before they become problems for you. HP's Proactive Support tool is designed to help businesses of all sizes reduce support costs and maximize productivity—all with the click of a mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control of your printing environment—with a clear focus on maximizing the value of your investment, increasing printer uptime and reducing printer management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems before they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for software and firmware updates.

You can enable Proactive Support in the HP DesignJet Utility for Windows or the HP Printer Monitor for Mac OS X, where you can specify the frequency of connections between your computer and HP's Web server, and the frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time. To change these settings:

- In the HP DesignJet Utility for Windows, click the **Tools** menu, then **HP Proactive Support** (not available in HP DesignJet Utility 1.0).
- In the HP Printer Monitor for Mac OS X, click **Preferences > Monitoring > Enable HP Proactive Support**.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the problem and recommend a solution. In some cases, the solution may be applied automatically; in other cases, you may be asked to perform some procedure to solve the problem.

**Customer Self Repair**

HP's Customer Self Repair program offers our customers the fastest service under either warranty or contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace them. Using this program, you can replace parts at your own convenience.

**Convenient, easy to use**

- An HP Support Specialist will diagnose and assess whether a replacement part is required to address a defective hardware component.
- Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact HP.
- Available for most HP products currently under warranty or contract.
- Available in most countries.

Contact HP Support

HP Support is available to you by telephone. What to do before you call:

- Review the troubleshooting suggestions in this guide.
- Review the relevant driver documentation.
- If you have installed third-party software drivers and RIPs, see their documentation.
- If you call one of the HP offices, please have the following information available to help us answer your questions more quickly:
  - The product you are using (the product number and the serial number, found on the label at the back of the product)
  - If there is an error code on the front panel, note it down; see Front-panel error messages on page 117
  - The computer you are using
  - Any special equipment or software you are using (for example, spoolers, networks, switch-boxes, modems or special software drivers)
  - The cable you are using (by part number) and where you purchased it
  - The type of interface used on your product (USB, network, or Wi-Fi)
  - The software name and version you are currently using
  - If possible, print out the following reports; you may be asked to fax them to the support center helping you: Configuration, Usage Report and “all pages above” from Service Information (see The printer’s internal prints on page 11)

Telephone number

18 Printer specifications

- Functional specifications
- Mobile Printing specifications
- Physical specifications
- Memory specifications
- Power specifications
- Ecological specifications
- Environmental specifications
- Acoustic specifications
## Functional specifications

### Table 18-1  HP 72 ink supplies

<table>
<thead>
<tr>
<th>Printhead</th>
<th>One printhead</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink cartridges</td>
<td>Cartridges containing 29 ml of ink: yellow, magenta, and cyan</td>
</tr>
<tr>
<td></td>
<td>Cartridges containing 38 ml of ink: black</td>
</tr>
<tr>
<td></td>
<td>Cartridges containing 80 ml of ink: black</td>
</tr>
</tbody>
</table>

### Table 18-2  Paper sizes

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roll width</td>
<td>279 mm (11 in)</td>
<td>610 mm (24 in) or 914 mm (36 in)</td>
</tr>
<tr>
<td>Roll length</td>
<td>46 m (150 feet)</td>
<td></td>
</tr>
<tr>
<td>Roll diameter</td>
<td>100 mm (3.9 in)</td>
<td></td>
</tr>
<tr>
<td>610 mm (24 in) roll weight</td>
<td>4.1 kg (9 lb)</td>
<td></td>
</tr>
<tr>
<td>914 mm (36 in) roll weight</td>
<td>6.2 kg (14 lb)</td>
<td></td>
</tr>
<tr>
<td>Sheet width</td>
<td>210 mm (8.27 in)</td>
<td></td>
</tr>
<tr>
<td>Sheet length</td>
<td>279 mm (11 in)</td>
<td>1676 mm (66 in)</td>
</tr>
<tr>
<td>Paper thickness</td>
<td>0.3 mm (0.01 in)</td>
<td></td>
</tr>
<tr>
<td>Paper weight</td>
<td>60 g/m²</td>
<td>280 g/m² (220 g/m² in multi-sheet tray)</td>
</tr>
</tbody>
</table>

### Table 18-3  Printing resolutions (T120)

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Maximum detail</th>
<th>Rendering resolution (ppi)</th>
<th>Printing resolution (dpi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best (glossy paper*)</td>
<td>On</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Best (other papers)</td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Normal</td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Fast</td>
<td>Off</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Econofast</td>
<td>Off</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
</tr>
</tbody>
</table>

### Table 18-4  Printing resolutions (T520)

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Maximum detail</th>
<th>Rendering resolution (ppi)</th>
<th>Printing resolution (dpi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best (glossy paper*)</td>
<td>On</td>
<td>1200 × 1200</td>
<td>2400 × 1200</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Best (other papers)</td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Normal</td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
</tbody>
</table>
Table 18-4 Printing resolutions (T520) (continued)

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Maximum detail</th>
<th>Rendering resolution (ppi)</th>
<th>Printing resolution (dpi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast</td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Econofast</td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
</tbody>
</table>

* For a list of supported glossy papers, see Order paper on page 80.

Table 18-5 Margins

| Top, bottom, right, and left margins | 5 mm (0.2 in) |

Table 18-6 Mechanical accuracy

±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/A0 printing material in Best or Normal mode with HP Matte Film roll feed.

Table 18-7 Graphic languages supported

<table>
<thead>
<tr>
<th>HP DesignJet</th>
<th>Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>T120</td>
<td>HP PCL3GUI</td>
</tr>
<tr>
<td>T520</td>
<td>HP PCL3GUI (Mac OS X), HP-GL/2 and HP RTL (Windows)</td>
</tr>
</tbody>
</table>

Mobile Printing specifications

Table 18-8 Mobile direct printing

<table>
<thead>
<tr>
<th>Software</th>
<th>iOS with AirPrint, or Android with HP Print Service Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile devices supported</td>
<td>Smartphones and tablets</td>
</tr>
<tr>
<td>Operating systems supported</td>
<td>iOS from 7.0, Android from 4.4, any version of Windows</td>
</tr>
<tr>
<td>Connectivity requirements</td>
<td>Printer and mobile device must use the same network</td>
</tr>
<tr>
<td>File formats supported</td>
<td>PDF, JPEG</td>
</tr>
</tbody>
</table>

Table 18-9 Email printing

<table>
<thead>
<tr>
<th>Software</th>
<th>HP ePrint</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile devices supported</td>
<td>Smartphones, tablets, computers</td>
</tr>
<tr>
<td>Operating systems supported</td>
<td>Any system with email capability</td>
</tr>
<tr>
<td>Connectivity requirements</td>
<td>Cloud connection</td>
</tr>
<tr>
<td>Cloud features</td>
<td>Remote printing through email</td>
</tr>
<tr>
<td>File formats supported</td>
<td>PDF, JPEG, TIFF</td>
</tr>
<tr>
<td>Maximum file size</td>
<td>10 MB</td>
</tr>
</tbody>
</table>
**Table 18-10** HP All-in-One Remote printing

<table>
<thead>
<tr>
<th>Software</th>
<th>HP All-in-One Printer Remote</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile devices supported</td>
<td>Smartphones, tablets</td>
</tr>
<tr>
<td>Operating systems supported</td>
<td>iOS from 7.0, Android from 4.4</td>
</tr>
<tr>
<td>Connectivity requirements</td>
<td>Printer and mobile device must use the same network</td>
</tr>
<tr>
<td>File formats supported</td>
<td>PDF, JPEG, webpages, email attachments, Microsoft Office documents</td>
</tr>
</tbody>
</table>

**Physical specifications**

**Table 18-11** Printer physical specifications

<table>
<thead>
<tr>
<th>HP DesignJet T120</th>
<th>HP DesignJet T520 24-in</th>
<th>HP DesignJet T520 36-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>25.5 kg (56.2 lb)</td>
<td>35 kg (77.2 lb)</td>
</tr>
<tr>
<td>Width</td>
<td>987.2 mm (38.87 in)</td>
<td>987.2 mm (38.87 in)</td>
</tr>
<tr>
<td>Depth Minimum:</td>
<td>275 mm (10.8 in)</td>
<td>936 mm (36.9 in) with stand</td>
</tr>
<tr>
<td></td>
<td>Maximum: 527 mm (20.7 in)</td>
<td>Maximum: 896 mm (35.3 in)</td>
</tr>
<tr>
<td>Height Minimum:</td>
<td>275 mm (10.8 in)</td>
<td>Maximum: 1155 mm (45.47 in) with stand and multi-sheet tray extended</td>
</tr>
<tr>
<td></td>
<td>Maximum: 502 mm (19.8 in)</td>
<td>Maximum: 936 mm (36.9 in) with stand</td>
</tr>
</tbody>
</table>

**Memory specifications**

**Table 18-12** Memory specifications

<table>
<thead>
<tr>
<th>HP DesignJet</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>T120</td>
<td>256 MB</td>
</tr>
<tr>
<td>T520</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

**Power specifications**

**Table 18-13** Printer power specifications

<table>
<thead>
<tr>
<th>Source</th>
<th>100–240 V ac ±10%, auto-ranging</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>50/60 Hz</td>
</tr>
<tr>
<td>Maximum current</td>
<td>1200 mA</td>
</tr>
<tr>
<td>Average consumption</td>
<td>35 W</td>
</tr>
</tbody>
</table>

**Ecological specifications**

This product complies with the WEEE Directive 2002/96/EC and RoHS Directive 2002/95/EC. To determine the ENERGY STAR qualification status of these product models, see [http://www.hp.com/go/energystar](http://www.hp.com/go/energystar).
Environmental specifications

Table 18-14 Printer environmental specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>5 to 40°C (41 to 104°F)</td>
</tr>
<tr>
<td>Recommended operating temperature</td>
<td>15 to 35°C (59 to 95°F), depending on paper type</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>–25 to 55°C (–13 to 131°F)</td>
</tr>
<tr>
<td>Recommended operating humidity</td>
<td>20 to 80% RH, depending on paper type</td>
</tr>
<tr>
<td>Storage humidity</td>
<td>0 to 95% RH</td>
</tr>
</tbody>
</table>

Acoustic specifications

Printer acoustic specifications (declared according to ISO 9296).

Table 18-15 Printer acoustic specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle sound power level</td>
<td>&lt; 3.4 B (A)</td>
</tr>
<tr>
<td>Operating sound power level</td>
<td>6.5 B (A)</td>
</tr>
<tr>
<td>Idle sound pressure at bystander position</td>
<td>&lt; 16 dB (A)</td>
</tr>
<tr>
<td>Operating sound pressure at bystander position</td>
<td>48 dB (A)</td>
</tr>
</tbody>
</table>
Bonjour
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when setting up the printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the printer (mainly metal parts) before handling ESD sensitive devices (such as the printhead or ink cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Fast Ethernet
An Ethernet network capable of transferring data at up to 100,000,000 bits/second. Fast Ethernet interfaces are capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.

Hi-Speed USB
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise compatible with original USB. Most personal computers today use Hi-Speed USB.
HP-GL/2
HP Graphics Language 2: a language defined by HP to describe vector graphics.

HP RTL
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

I/O
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec
A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between nodes on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually unaware whether IPSec is being used or not.

IPv4 address
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers separated by full stops. Most networks in the world use IPv4 addresses.

IPv6 address
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of hexadecimal digits separated by colons. Each group contains up to 4 hexadecimal digits. Only a few new networks in the world use IPv6 addresses.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

Network
A network is a set of connections that pass data between computers and devices. Every device is able to communicate with every other device in the same network. This allows data to be moved between computers and devices, and allows devices such as printers to be shared between many computers.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped, dried and pressed.

Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it on the paper, through a cluster of nozzles.

Spindle
A rod that supports a roll of paper while it is being used for printing.
TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your printer supports Hi-Speed USB (sometimes called USB 2.0).

USB device port
A square USB socket found on USB devices, though which a computer can control the device. For a computer to print to your printer using a USB connection, the computer must be connected to the printer’s USB device port.

USB host port
A rectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.

WiFi
This term is used for any wireless local area network products that are based on the Institute of Electrical and Electronics Engineers’ (IEEE) 802.11 standards.
Index

A
access control 21
accessories
    order 83
acoustic specifications 127
Acrobat, print from 49
alerts
    errors 116
    turn on and off 20
    warnings 116
auto-off 25
AutoCAD, print from 51
automatic firmware update, configure 20

B
banding problems 76
bin
    output problems 92
black and white 47
blurred lines 98
brightness in front panel 25

C
cannot load paper 85
care of the printer 69
clean the platen 101
clean the printer 69
clipped at bottom 103
clipped image 103
color
    fading 102
    inaccurate 102
communication ports 7
components of printer 5
computer communication
    printer/computer communications issues 108
connect the printer
    choose a method 13
    general 13
    Mac OS X network 15
    Mac OS X USB 17
Windows network 13
    Windows USB 14
Customer Care 120
Customer Self Repair 121
cutter
    on/off 37

D
draft printing 45
driver preferences 21
drying time
    change 37

economize on ink 45
    on paper 45
e-mail notifications 20
e-mail printing 40
Embedded Web Server
    access 24
    cannot access 116
    language 24
encoder strip
    clean 76
environmental specifications 127
error messages
    front panel 117

F
fading colors 102
features of printer 4
firmware update 77
    configure automatic 20
front panel
    brightness 25
    language 24
front panel option
    align printhead 71
    auto-off 25
    calibrate ready paper 76
    clean printhead 70
display brightness 25
enable cutter 37
firmware update 78
form feed 38
form feed and cut 38
print diagnostic image 69
replace printhead 71
reset ready paper calibration 77
select drying time 37
select I/O timeout 103
select language 24
sleep 25
unload roll 34
front view T520 5
functional specifications 124

G
graininess 99
graphic languages 125
gray shades 47
grayscale 47

H
hard disk specification 126
HP Care Packs 120
HP Click 41
HP Customer Care 120
HP ePrint 40
HP Installation 121
HP Proactive Support 121
HP Start-Up Kit 120
HP Start-Up Kit DVD 2
HP Support 122
HP Support Center 120
HP Utility
    access 24
    language 25

I
image problems
    clipped at bottom 103
    clipped image 103
missing objects 103
PDF problems 104
ink
economical use of 45
ink cartridge
about 65
cannot insert 106
memory chip 65
order 80
replace 65
specification 124
status 65
status messages 106
ink cartridge; usage information 65
internal prints 11
IP address 24
static 108
use hostname 108
L
language 24
line length accuracy 98
line thickness 96
load paper
cannot load 85
general advice 30
multi-sheet tray 35
paper not in driver 87
roll cannot load 85
roll into printer 32
roll onto spindle 30
sheet 34
sheet cannot load 85
sheet cannot load from tray 86
loading paper problems 85
M
maintenance kits 78
margins 43
specification 125
mechanical accuracy 125
memory specifications 126
Microsoft Office, print from 57
misaligned colors 97
mobile printing 40
introduction 9
setup 22
troubleshooting 112
mobile specifications 125
models, printer 3
move the printer 77
N
network configuration page 112
network settings 26
network troubleshooting, wired 109
network troubleshooting, wireless 109
O
order
accessories 83
ink cartridges 80
paper 80
printhead 80
P
page size 42
paper
advance 38
calibrate the paper advance 76
cannot load 85
cut after printing 93
economical use of 45
form feed 38
form feed and cut 38
incorrect out of paper 92
jam due to cut strip 92
loading error messages 86
maintenance 37
mismatch 88
not cut well 93
not flat 99
output problems in bin 92
paper not in driver 87
print on loaded paper 44, 88
printed on wrong paper 88
retained by printer 92
roll jammed 88
roll loose on spindle 93
select type 44
size 42
sizes (max and min) 124
tray jammed 90
view information 37
paper not in driver 87
paper types 80
PDF clipped 104
PDF missing objects 104
Photoshop, print from 55
physical specifications 126
platen cleaning 101
ports 7
power
on/off 10
power specifications 126
preferences, Windows driver 21
print from
printer driver 41
print from mobile 40
print quality
select 41
print quality diagnostic report 69
print-quality problems
banding 95
black ink comes off 101
blurred lines 98
discontinuous lines 97
edges darker than expected 101
edges stepped or not sharp 101
general 95
graininess 99
horizontal lines 95
inaccurate line lengths 98
ink marks 100
line thickness 96
misaligned colors 97
paper not flat 99
scratching 100
scuffing 100
stepped lines 96
vertical lines of different colors 102
white spots 102
printer does not print 115
printer does not start 115
printer emulation 46
printer models 3
printer security 28
printer software 8
printer status 69
printer's main components 5
printer's main features 4
printhead
about 67
align 71
cannot insert 106
clean; purge 70
order 80
replace 71
specification 124
printhead cleaner
specification 124
printing 39
printing resolutions 124
Proactive Support 121
Q
quality, high 45
R
rear view T120, T520-24T 6
rear view T520 6
rescale a print 44
roll paper
  load 32
  spindle load 30
  unload 34
S
safety precautions 2
scale a print 44
scratched prints 100
scuffed prints 100
security 21
sheet paper
  load 34
  unload 35
  use multi-sheet tray 35
sleep mode wait time 25
slow printing 115
software 8
software update 78
specifications
  acoustic 127
  ecological 126
  environmental 127
  functional 124
  graphic languages 125
  hard disk 126
  ink supplies 124
  margins 125
  mechanical accuracy 125
  memory 126
  mobile 125
  paper size 124
  physical 126
  power 126
  printing resolutions 124
spindle 83
  roll load 30
stand 83
statistics
  ink cartridge 65
  stepped lines 96
store the printer 77
support services
  HP Care Packs 120
  HP Customer Care 120
  HP Proactive Support 121
  HP Start-Up Kit 120
  HP Support 122
  HP Support Center 120
printer installation 121
warranty extensions 120
T
telephone number 122
U
unload paper
  roll 34
  sheet 35
usage information stored in cartridge 65
using this guide 2
W
warranty extensions 120
web services
  setup 22